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KATA PENGANTAR 

 

Alhamdulillah segala puja dan puji syukur kehadirat Allah SWT 

telah memberikan rahmat-Nya sehingga Buku Desan Grafis untuk 

tingkat lanjut yang punya keinginan untuk mendalami efek manipulasi 

suatu foto, Buku Desan Grafis Kreasi Efek Photoshop CC tersebut. 

Buku Desan Grafis Kreasi Efek Photoshop CC dengan kreasi 

efek tersebut berisi tentang tutorial penggunaan dari fitur aplikasi 

photoshop serta mengenal manipulasi dengan aplikasi photoshop 

dengan efek-efek manipulasi suatu foto atau gambar. Pelaksanaan 

teknik desain grafis efek dan manipulasi foto lebih diutamakan serta 

dibahas secara detail dari teknik-tekniknya. 

 Penulis dengan menyusun pembuatan Buku Desan Grafis Kreasi 

Efek Photoshop CC tersebut di gunakan untuk membantu para 

mahasiswa/i. Dalam penyelesaian penyusunan buku masih dalam 

tahapan kurang sempurna maka diharapkan penyusun mengharapkan 

dari kritik maupun saran guna untuk penyempurnaan penyusunan buku 

lebih lanjut.   

 Atas perhatiannya semuanya kami penyusun mengucapkan 

banyak terimakasih kepada semua kalangan untuk membangun suatu 

karya agar lebih baik lagi. 

 

 

Semarang,   November 2020 

 

 

Teguh Setiadi, S.Kom.,M.Kom 

Penulis 
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BAB I PENDAHULUAN 

A. Latar Belakang 

Adobe photoshop adalah salah satu aplikasi yang sangat familiar di 

khalayak umum. Aplikasi tersebut memiliki peran penting di dunia grafis 

salah satunya digunakan untuk editing foto gambar dalam bentuk file 

bitmad hasil dari pengambilan gambar seperti dengan kamera saku 

maupun kamera dslr. Perkembangan adobe photoshop semakin hari 

semakin banyak perubahan dalam arti aplikasi tersebut memiliki banyak 

fitur-fitur yang menarik dapat mempermudah kinerja editing gambar. 

Kinerja aplikasi tidak luput dari penggunaan komputer atau kinerja dari 

komputer karena suatu komputer dengan spesifikasi sangat mendukung, 

misalkan menggunakan komputer dengan spesifikasi Ram 4 Gb dan 

Prosesor Core i5 salah satunya memungkinkan sangat membantu kinerja 

dari komputer tersebut. Dalam perkembangan adobe photoshop sudah 

memiliki versi yang terbaru salah satunya CC 2019 karena memiliki banyak 

fitur-fitur dan juga sangat banyak efek-efek. Maka seorang partisi kompter 

dengan banyak belajar terbaru dan juga didukung komputer harus support 

untuk kierjanya. Penting sekali aplikasi adobe photoshop versi CC 2019 

untuk membantu para desainer dibidang pengolah gambar digital, 

didalam buku tersebut akan dibahas tentang tutorial-turorial dari efek-

efek adobe photoshop CC 2019. 

 

B. Tujuan Penulisan 

Adapun tujuan penulisan buku tersebut antara lain: 

1. Membahas aplikasi adobe photoshop 

2. Fungsi tools dan efek Aplikasi adobe photoshop 

3. Mendalami dari kelebihan mengetahui fitur-fitur yang menarik dalam 

Photoshop terbaru CC 2019 

4. Mempermudah mengedit gambar atau manipulasi gambar foto 

(bitmap) 

5. Mengetahui secara teknik cepat desain web e-commerce 

 

C. Cuplikan Adobe Photoshop 

Adobe Photoshop salah satu aplikasi yang berperan penting untuk 

editing pengolahan citra digital. Pada awal mulanya aplikasi tersebut 
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dikembangkan oleh Thomas Knoll seorang mahasiswa yang lulusan dari 

Universitas Michigan dengan menyandang gelas PhD dapa tahun 1987. 

Pengembang telah sukses pada awal tahun 1990 dilirisnya aplikasi 

Photoshop versi pertama (1.0). Perkembangan dari tahun ke tahun 

aplikasi tersebut melahirkan versi terbarunya versi 2.0, 3.0, 4.0, 5.0, 7.0 

setelah itu berubah mencadi CS sampai dengan CS6 dan yeng terbaru lagi 

versi CC yang terbaru CC 2019.  Pada versi CS dengan singkatan (Creative 

Suite) dapa awalnya tersebut sangat diminati banyak seorang editing foto 

maupun desain grafis menggunakannya dengang sudah banyak fitur yang 

ada. Adapun efek yang digunakan sangat dikembangkan yang terbaru. 

Perkembangan sekarang tersebut Photoshop telah terbaru yaitu 

Photoshop CC 2019 secara resmi diliris tahun 2019 yang paling terbaru 

tetapi pihak vendor dari adobe tiap tahunnya selalu uptudate aplikasinya 

yang terbaru dan mereka juga menyediakan versi uji coba dalam 30 hari 

untuk medapatkan komentar dari semua pengguna untuk versi yang 

barunya, dan menampilkan banyak perbedaan antara fitur dan efeknya 

serta tata layout juga agak berbeda dari versi sebelumnnya.  

Perangkat lunak adobe Photoshop CC 2019 tersebut adalah yang 

paling terbaru untuk saat tersebut, tentunya software tersebut datang 

untuk memperbaiki kemampuan para pendahulunya. Sementara 

beberapa perubahan yang lebih kecil yang dirancang untuk pro 

Photoshop, banyak update terbaru perangkat lunak bertujuan untuk 

menyederhanakan alat grafis mapan. Sebuah bar pencarian universal baru 

akan memunculkan segala sesuatu dari topik bantuan ke lokasi alat 

panen. Dengan Adobe Stock sekarang terintegrasi langsung dengan 

platform, pencarian juga akan memunculkan stok foto. Ikon pencarian di 

pojok kanan atas dan mencari segala sesuatu secara default, tetapi dapat 

disesuaikan untuk mencari hanya dalam Photoshop atau hanya dalam 

tutorial online, misalnya.Adobe tidak meninggalkan Photoshoppers 

veteran di update, dan diarahkan beberapa alat canggih dan perangkat 

tambahan jalan mereka. Photoshop sekarang kompatibel dengan Scalable 

Vector Graphic (SVG) font. Tersebut grafis standar yang berbeda dari font 

biasa karena mengandung kedua warna dan bentuk informasi dan diakses 

secara universal di sebagian besar web browser. font SVG tersebut 
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kompatibel dengan beta publik Program Adobe desain aplikasi, Experience 

Design, atau XD. 

Pada tutorial yang akan dibahas photoshop CC 2019 dalam buku 

tersebut, menampilkan banyak perbaikan dan fitur yang ditambahkan 

pada rilis baru tersebut. Fitur dan perangkat tambahan Adobe untuk 

Photoshop mengikuti dua tema. Buat Photoshop yang lebih modern dan 

lebih terhubung, turunkan penghalang pembelajaran untuk pemula. 

Photoshop sekarang lebih terhubung ke Creative Cloud dan aplikasi 

lainnya di ekosistem Adobe. Pada dasarnya untuk versi dari photoshop CC 

2019 tersebut kinerjanya begitu ringan dibanding dengan versi yang lama 

karena versi tersebut juga memiliki beberapa teknik dari pengolahan citra 

dengan konsep manipulasi digital yang telah membuat versi aplikasi 

tersebut banyak pengembangan dan perubahan, dibawah tersebut adalah 

beberapa fitur yang dari versi CC sebegai berikut: 

1. Teknologi dengan pengolahalan digital 

2. Efek yang terbaru dalam editing gambar 

3. Performa didukug teknologi (GPU) 

4. Teknologi GUI  

5. Hasil dari rendering gambar riel 

6. Tools lebih banyak kelengkapannya 

Keunggulan dari aplikasi  Photoshop photoshop CC dalam bentuk 

pengolah warna sebegai berikut : 

1. Bitmap dalam bentuk foto warna 

2. Grayscale bisa dalam warna hitam putih 

3. Duotone lebih dari untuk teknik sablon 

4. CMYK full color untuk teknik cetak 

5. RGB untuk menampilkan hasil gambar berbasis destop 

Dunia perkembangan dibidang teknologi manipulasi digital sudah 

banyak yang masuk dan menggelutinya salah satunya menciptakan karya-

karya yang menarik serta memberikan pesan dari editing foto yang 

professional dibidangnya teknik tersebut membangun atau mengubah 

cara pandang manusia untuk mempelajarinya. Hal tersebut manipulasi 

foto sangatlah penting apalagi didunia grafis alat olah digital semakin maju 

dan dapat mudah digunakannya. Sekarang orang berbondong-bondong 
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untuk belajar dunia grafis, salah satunya program adobe photoshop 

membuka wahana bagi semua orang untuk belajar editing gambar. 

Dibawah tersebut adalah tampilan awal wajah baru dari Adobe Photoshop 

CC 2019 sebagai berikut : 

 
Gambar 1.1 Tampilan awal Adobe Photoshop CC 2019 

Dari gambar diatas salah satunya dari semua fitur baru dari rilis 

terakhir, Photoshop CC 2019, semuanya mendapatkan upgrade dan fitur 

tambahan. Aplikasi tersebut sangat perperan penting yang dapat digunkan 

untuk mempermudah editing dan konsep yang selalu memberikan 

tahapan dari editing gambar yang didasar dengan membuat teknik 

gambar sederhana yang memiliki perbedaan serta memasukkan 

permintaan fitur agar lebih terkontrol dan presisi dalam perubahan versi 

memilliki perbedaaan salah satunya adalah tamppiln muka dari aplikasi 

tersebut. 

Pembaruan Utama: 

• Mulai Workspace 

• Jendela Dokumen Baru 

• Cari 

• Font Warna SVG 

• Perbaikan Panel Properties 

• Perbaikan Panel Perpustakaan 
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D. Penggunaan interface  

1. Mulai tampilan Workspace  

Ruang kerja Start diperkenalkan di Photoshop CC selama 

update bulan November 2015. Layar tersebut ditampilkan saat Anda 

pertama kali meluncurkan Photoshop atau bila tidak ada dokumen 

yang terbuka.  

 
Gambar 1.2 Tampilan Start Workspace Photoshop CC 2015  

Photoshop CC 2019 membuat perubahan kecil namun 

signifikan pada Start Workspace tersebut. Seperti versi awal dari ruang 

kerja Start, Photoshop CC 2019 memberi Anda akses cepat ke file 

terbaru Anda. Tapi CC 2019 menghapus dua tab utama, tab Libraries 

and Presets, dan menggantinya dengan tab File CC. 

 

CC 2017 
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Gambar 1.3 Tampilan Start Workspace Photoshop CC 2017 & CC 2019  

 
2. Penyesuaian Jumlah File Terbaru 

Bagi anda yang ingin menyesuaikan jumlah file terbaru yang 

dapat ditampilkan ke dalam daftar File Terbaru, masuk ke dialog 

Preferences dengan menekan Ctrl+ K pada keyboard anda. Di tab File 

Handling, di bawah Recent File List Berisi masukkan jumlah file terbaru 

yang ingin Anda tampilkan (antara 0 dan 100) dapat ditunjukkan 

gambar dibawah tersebut. 

 
Gambar 1.4 Tampilan dialog Preferences 

3. Keluar atau Non aktifkan Start Workspace 

Untuk segera keluar dari Start Workspace anda cukup 

menekan tombol Esc. Untuk menonaktifkan Start Workspace secara 

permanen, masuklah ke Preferences dialog dengan menekan Ctrl+ K 

CC 2019 
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pada keyboard anda. Di bawah General, hapus di centang pada 

tampilan “Show ‘Start’ Workspace When No Documents Are Open”. 

Dapat dilihat tampilan general dibawah tersebut. 

 
Gambar 1.5 Tampilan dialog general 

 
4. Jendela Dokumen Baru (New Document Document) 

Salah satu perubahan terbesar pada Adobe Photoshop CC 2019 

adalah kotak dialog New Document yang didesain ulang sepenuhnya. 

Desain ulang tersebut masih memiliki semua fungsi dari kotak dialog, 

namun dengan tata letak yang lebih modern dan visualnya yang lebih 

menarik. Tapi update tersebut lebih dari sekadar perubahan tampilan 

dari interface. Pada tampian Dialog Dokumen Baru sekarang dilengkapi 

dengan template gratis dari Adobe Stock yang memungkinkan untuk 

anda yang banyak kreasi dalam desain dapat memilih layoud tersebut. 

Bagi anda dapat menampilkan jendela New Document dengan 

menggunakan shortcut keyboard Ctrl+N pada keyboard anda atau 

dengan membuka File > New, dapat dilihat tampilannya sebagai 

berikut tersebut. 



8 
 

Desain Grafis (KREASI EFEK PHOTOSHOP CC) 

 

 
Gambar 1.6 Tampilan jendela New Document 

Penggunaan selanjutnya untuk Kotak dialog New Document 

mempunyai kelebihan, pada desain ulang jendela New Document 

memungkinkan untuk anda yang diatur sebagai berikut: 

• Buat dokumen menggunakan template dari Adobe Stock,  

• Simpan preset kustom 

• Buat dokumen menggunakan Preset Dokumen Kosong dari 

beberapa kategori. 

Jika anda adalah orang yang tidak menyukai perubahan, anda 

bisa kembali ke kotak dialog New Document yang baru. Cukup masuk 

ke dialog Preferences dengan menekan Ctrl+K pada keyboard anda 

dan di bawah tab General centang kotak “Use Legacy ‘File New’ 

Interface” dapat ditunjukkan pada gambar berikut tersebut. 
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Gambar 1.7 Tampilan jendela General  

Dialog Dokumen Baru berisi dua jenis preset yang akan 

membantu Anda untuk memulai proses penentuan penggunaannya, 

yaitu Blank Document Preset, dan template Photoshop. Dijelaskan 

penggunaannya atara lain. 

5. Blank Document Preset 

Template dokumen kosong (Blank Document Preset) serupa 

dengan apa yang kita miliki di versi sebelumnya dari Photoshop. Pada 

dokumen kosong (Blank Document) berdasarkan dengan ukuran 

dokumen, resolusi dan profil warna yang telah ditentukan sebelumnya. 

Di Photoshop CC 2019 dengan memberikan tampilan template 

dokumen kosong tersebut bekerja sama, namun disatukan antara tata 

letak yang lebih modern dan visualnya, tampilannya adalah sebagai 

berikut. 
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Gambar 1.8 Tampilan jendela Blank Document Preset 

 
6. Blank Document Preset untuk proyek Foto 

Pada versi Photoshop CC yang lebih lama, Anda dapat 

membuat preset dokumen kosong Anda sendiri atau menggunakan 

salah satu dari banyak preset yang ditemukan dalam enam kategori: 

• Foto 

• Cetakan 

• Seni dan Ilustrasi 

• Website 

• Seluler 

• Film & Video 
7. Photoshop Templates 

Salah satu penambahan terbesar dan paling terkenal pada 

Photoshop CC 2019 adalah template Photoshop yang disediakan dalam 

dialog New Document. Template Photoshop tersebut adalah file yang 

dapat Anda gunakan untuk diketahui dari beberapa isi dari template 

tersebut. Ratusan Template Photoshop gratis disediakan oleh Adobe 

Stock. Mereka termasuk file yang berisi brosur, selebaran, grafis gerak, 

lapisan video dan masih banyak lagi. Anda bisa mencari template 

dengan memilih kategori, Foto, Cetak, Seni & Ilustrasi, Website, Seluler 

serta Film dan Video. Bila memilih kategori, Anda bisa melihat daftar 
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template yang tersedia dengan cara mengklik template akan 

mengungkapkan detail template di sebelah kanan kotak dialog. 

 
Gambar 1.9 Tampilan jendela Photoshop Templates 

 
Template Photoshop untuk proyek Foto yang pertama kali 

Anda menggunakan template gratis tersebut, Anda perlu 

mengunduhnya dan memberi lisensi dari Adobe Stock sebelum Anda 

dapat memulai penggunaanya. Bila anda sudah megunduh template 

maka akan keluar centang biru pada lingkaran dapat dilihat dibawah 

tersebut pada library panel. 
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Gambar 1.10 Tampilan Libraries Pannel in Photoshop CC 2019 

8. Photoshop Search Feature 

Salah satu penambahan terbaik dan paling penting untuk 

Adobe Photoshop CC 2019 adalah Pencarian multi-lingkup yang hebat 

untuk pencariannya. Anda bisa memikirkannya seperti Google di dalam 

Photoshop. Tersebut adalah alat yang hebat untuk pemula dalam 

penggunaannya. Anda bisa menggunakan fitur Photoshop Search untuk 

menemukan alat, menu, tutorial, tip, aset, dokumen, lapisan dan 

banyak lagi; Semua dari kotak dialog terpadu. Penelusuran terintegrasi 

dengan Adobe Stock untuk membantu Anda menemukan aset dan 

Template Photoshop. Pencarian juga terintegrasi dengan 

helpx.adobe.com untuk mengambil dokumentasi bantuan dan materi 

instruksional yang relevan. Untuk membuka kotak Pencarian 

Photoshop tekan Ctrl+F pada keyboard anda. 

 
Gambar 1.11 Tampilan Pencarian multi-lingkup 

 
Catatan: Pada versi sebelumnya Photoshop dengan menekan 

tombol Ctrl+F adalah shortcut keyboard untuk mengaplikasikan 

kembali filter yang terakhir digunakan. Untuk mencari filter terakhir 

yang digunakan di Photoshop CC 2019 dengan menekan Ctrl+Alt+F 

dengan keyboard. Untuk memulai pencarian cukup ketik mengetik di 

kotak pencarian. Photoshop akan segera mulai menghasilkan konten 

berdasarkan karakter yang anda masukkan tersebut. Permintaan 

pencarian akan menghasilkan hasil dalam tiga kategori: Photoshop, 

Learn, and Stock. Secara default, anda akan melihat hasil dari semua 

kategori, namun anda dapat memfilter berdasarkan kategori dengan 

mengeklik label tab di bawah kotak Cari. 
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Gambar 1.12 Tampilan Crop Photoshop, Learn, and Stock 
Pencarian Photoshop salah satu hal terbaik tentang fitur 

Pencarian Photoshop adalah Anda dapat melakukan penggunaanya 

den mengoperasikan yang terkait dengan hasil pencarian hanya 

dengan mengkliknya. Tersebut adalah penghematan waktu dan 

tersebut juga dapat membantu anda untuk menemukan fungsi-fungsi 

yang mungkin belum Anda ketahui sebelumnya. Pada tool pencarian 

dijelaskan sebagai berikut: 

• Layer :  Pilih layer dan buat terlihat di panel 
Layers. 

• Tool  :  Mengaktifkan alat dan menyorotinya. 
• Panel :  Membuat panel terlihat dan aktif. 
• Filter  : Menerapkan filter atau membuka dialog 

untuk filter tersebut. 
• Menu :  Menjalankan perintah.  
• New File :  Membuka file. 
• Open Documents :  Mengaktifkan dokumen. 
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• Help or Learn Topics :  Membuka artikel di browser default Anda. 
• Stock Asset : Download aset gambar ke dalam 

perpustakaan Creative Cloud   aktif Anda, dan 
tempatkan aset Cloud-Linked di kanvas. 

Pencarian Photoshop memiliki algoritma lanjutan yang 

memungkinkan penggunaan sinonim. Misalnya, mencari “Retouch” 

akan mengembalikan hasil pencarian yang relevan dengan retouching. 

Tersebut termasuk alat seperti:  

a. Clone Stamp Tool, untuk menggandakan gambar 

b. Healing Brush Tool, untuk membuat goresan dari kuas, dan  

c. Patch Tool untuk membuat garis sesuai selera kita 

 
Gambar 1.13 Tampilan Pencarian Retouch 

Fitur pada Photoshop CC 2019 untuk pencarian mendukung 

semua bahasa, meski hasil pencarian bisa berbeda menurut bahasa, 

karena perbedaan dalam setiap bahasa beberapa item yang tidak 

disertakan dalam Photoshop Search didalam elemen library. 
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9. SVG Color Fonts 

Peningkatan terbesar untuk Type di Photoshop CC 2019 adalah 

penambahan SVG Color Fonts ke daftar jenis font yang didukung. Font 

SVG mendukung banyak warna dan gradien dalam Photoshop CC 2019. 

Saat bekerja dengan font SVG, penting untuk dicatat bahwa 

Anda perlu membuka Panel Glyph (Window> Glyphs) untuk memiliki 

akses ke berbagai karakter yang tersedia. Tersebut karena banyak dari 

font tersebut tidak memiliki kunci yang sesuai dengan karakter yang 

ditemukan di font tersebut. Dalam beberapa kasus antara lain entri 

keyboard mungkin berhasil, namun hanya akan menampilkan karakter 

menggunakan satu skema warna. Meski banyak yang lain termasuk 

dalam font. Misalnya font Konsep Trajan Color mencakup 20 rangkaian 

karakter yang berbeda yang hanya tersedia melalui panel Glyphs. Font 

juga membentuk karakter Ikon yang digunakan untuk menunjukkan 

jenis font maka dapat dilihat sebagai berikut. 

 
Gambar 1.14 Tampilan SVG Color Fonts 

 
10. Persyaratan Sistem Photoshop CC 2019 
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Untuk menggunakan aplikasi dari photoshop CC 2019 maka 

direkomendasikan untuk komputer OS (operating system) windows 

dan OS (operating system) Mac yang dijabarkan sebagai berikut: 

a. Windows 
• Prosesor menggunakan Intel Core i3 atau AMD Athlon 64; 

Prosesor 2 GHz  
• Mtersebutmal menggunkan Windows 7 dengan Service Pack 

1, bias juga menggunkan maksimal Windows 8.1, atau 
Windows 10 

• Minmal dengan RAM 2 GB atau disarankan 8 GB untuk lebih 
optimal 

• Penyimpanan dengan ruang hard disk 2.6 GB dengan instalasi 
32-bit, sedangkan untuk ruang hard disk 3,1 GB instalasi 64-
bit. 

• Direkomendasikan tampilan dari layar mtersebutmal 1024 
pixel x 768 pixel atau disarankan 1280 × 800 dengan warna 16 
bit dan RAM 2 GB 

• Untuk windows perlu diregistrasi agar aktivasi tidak masuk ke 
ranah online windows 

b. Mac OS 
• Prosesor menggunakan multicore Intel sistem instalansi 

dengan 64-bit 
• MacOS Versi 64-bit dengan mac 10.12 (Sierra), mac 10.11 (El 

Capitan), dan mac 10.10 (Yosemite) 
• Minmal dengan RAM 2 GB atau disarankan 8 GB untuk lebih 

optimal 
• Penyimpanan dengan ruang hard disk 4 GB 
• Direkomendasikan tampilan dari layar mtersebutmal 1024 

pixel x 768 pixel atau disarankan 1280 × 800 dengan warna 16 
bit dan RAM 2 GB 

• Untuk windows perlu diregistrasi agar aktivasi tidak masuk ke 
ranah online windows 

• Untuk fitur 3D pada aplikasi photoshop pada sistem 32-bit 
dapat di non aktifkan karena tidak didukung pada sistemnya. 

 
 
E. Teknik instalansi software 

Secara umum instalansi aplikasi semua sama tinggal masukkan 

aplikasi trus di double klik jalankan sampai 100% sampai selesai, tapi 
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semua orang banyak yang masih kurang tau tentang instalansi. Apa lagi 

software tersebut trial haya 30 hari 7 hari dan tidak bisa permanen untuk 

itu mari kita melakukan cara tepat untuk instalansinya, dapat dilihat 

dibawah tersebut. 

1. Langkah instalansi dengan doble klik pada aplikasinya seperti berikut 

tersebut. 

 
Gambar 1.15 Tampilan aplikasi adobe photoshop CC 2019 

 
2. Melanjutkan progres instalansi aplikasi sampai ke 100% dan sukses. 

 
Gambar 1.16 Tampilan progres instalansi adobe photoshop CC 2019 
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3. Setelah progres instalansi maka berhasil dan sukses tinggal tunggu 

untuk melihat tambahan masukkan lisensinya. 

 
Gambar 1.17 Tampilan progres instalansi sukses 2017/2019 

4. Dibawah tersebut melakukan lisensi dengan trial 7 hari dengan klik 

accept. 

 
Gambar 1.18 Tampilan license Agreemet 
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5. Agar aplikasi tersebut tidak lagi trial maka dengan menggunakan patch 

adalah semacam kunci dengan klik dan pilih adobe Photoshop CC 2017 

dan pilih install, dapat dilihat sebagai berikut tersebut. 

 
Gambar 1.19 Tampilan patch 

6. Setelah diklik install maka akan keluar mencari tempat tersebut, pillih 

di window selanjutnya masukkan dengan kode amtlib.dll 

diiplementasikan di folder adobe photoshopnya 2017 klik open. 

 
Gambar 1.20 Tampilan kode amtlib 

7. Setelah berjalan install maka telah selesai juga, dibawah tersebut 

adalah yang sudah selesai di install. 



20 
 

Desain Grafis (KREASI EFEK PHOTOSHOP CC) 

 

 
Gambar 1.21 Tampilan install patch  

8. Selanjutnya seteah selesai maka dibuka dulu dengan klik botom, pilih 

adobe photoshop cc 2019. 

 
Gambar 1.22 Tampilan dibuka aplikasinya 

9. Selanjutnya tampilan scren dari photosop haru dengan tampilan yang 

juga sangat bagus, 
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Gambar 1.22 Tampilan dibuka dan cari informasi 

10. Setelah itu muncul dengan sangat berbeda dari, langsung awal dari cc 

2019 

 
Gambar 1.23 Tampilan baru photo  

11. Selanjutnya dengan kontak untuk menunjukan dibawah tersebut, pilih 

new klik selesai. 
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Gambar 1.24 Tampilan recent file  

12. Senjutnya jika kita menginginkan dari print maka tinggal ganti toko > 

create 

 
Gambar 1.25 Tampilan recent  

13. Jika anda ingi dengan ukuran kertas dengan klik print lalu pilih A4, 

selanjutnya klik tombol create. 
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Gambar 1.26 Tampilan print untuk ukuran kertas  

14. Sesudah selesai maka dengan muncul dokumen baru dari setingan A4 

 
Gambar 1.27 Tampilan dokumen baru dan setingan A4 
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Tujuan BAB 1 

Adapun tujuan pada bab 1 adalah sebagai berikut : 

1. Mengetahui tentang perkembangan  Adobe photoshop 

2. Mengetahui cara instalansi aplikasi Adobe photoshop CC 2019 

3. Mengetahui fitur-fitur dari update Adobe photoshop versi CC 2019 

4. Mengetahui teknik membuat layout yang sudah di siapkan oleh Adobe 

photoshop CC 2019 

5. Memudahkan belajar secara teknik-teknik tools yang ada Adobe 

photoshop  

  

Kesimpulan  

Materi BAB 1 

Kesimpulan dengan menggunakan versi Photoshop CC 2019 adalah 

salah satunya mempermudah bagi desain dalam bentuk pengolah gambar 

digital dengan menggunakan macam-macam fitur yang menarik dan 

mempermudah bagi fungsi-fungsi yang terbaru editing foto maupun 

manipulasi gambar digital salah satunya memberikan tindakan yang paling 

menarik untuk editing dalam bentuk apapun, bagi yang belajar pada bab 1 

tersebut mempermudah mengetahui dasar-dasar dari fungsi dari versi 

terbaru CC tersebut.  

Pada kelebihan Photoshop CC 2019 memiliki keunggulan salah 

satu penambahan terbesar dan paling terkenal pada Photoshop CC 2019 

adalah template Photoshop yang disediakan dalam dialog New Document. 

Template Photoshop tersebut adalah file yang dapat Anda gunakan untuk 

diketahui dari beberapa isi dari template tersebut. Ratusan Template 

Photoshop gratis disediakan oleh Adobe Stock. Mereka termasuk file yang 

berisi brosur, selebaran, grafis gerak, lapisan video dan masih banyak lagi. 

Anda bisa mencari template dengan memilih kategori, Foto, Cetak, Seni & 

Ilustrasi, Web, Seluler, dan Film & Video. Bila memilih kategori, Anda bisa 

melihat daftar template yang tersedia dengan cara mengklik template.  

Fasilitas tambahan Adobe Photoshop CC 2019 salah satunya 

penambahan terbaik dan paling penting untuk Adobe Photoshop CC 2019 

adalah Pencarian multi-lingkup yang hebat untuk pencariannya seperti 

pada Google di dalam Photoshop CC 2019. Tersebut adalah alat yang 
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hebat untuk pemula dalam penggunaannya yaitu fitur Photoshop Search 

untuk menemukan alat, menu, tutorial, tip, aset, dokumen. 

Pemanfaatan buku yang dipelajari dengan mengupanyakan belajar 

dengan cara individu maupun dengan tentor yang berpengalaman karena 

belajar dalam bentuk editing foto juga memberikan dasar untuk semua 

untuk mempelajarinya dalam bentuk ektra kulikuler maupun mandiri yang 

sangat bermanfaat bagi perserta didik. 
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BAB II AREA KERJA PHOTOSHOP 

 

A. Area Kerja 

Pada Photoshop CC 2019 mempunya area kerja yang 

digunakan untuk operasi editing foto atau  gambar, area kerja dari 

software atau aplikasi dapat ditunjukkan pada gambar sebagai 

berikut. 

 
Gambar 2.1 Tampilan area kerja pada Photoshop CC 2019 

 

Keterangan : 

A. Tampilan Menu 

B. Tampilan Tool Option Bar 

C. Tampilan Palette Well 

D. Tampilan Tool Box 

E. Tampilan Status Bar 

F. Tampilan Area Gambar 

G. Tampilan Navigation Palette, Color Palette, History Palette, Layer 

Palette (dari atas ke bawah) 
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B. Fungsi Area Kerja 

Dibawah tersebut akan dijelaskan penggunaan dari fungsi-fungsi 

dari are kerja photoshop CC 2019 diantara lain; 

a). MENU 

 
Gambar 2.2 Tampilan menu pada Photoshop CC 2019 

 

Pada gamba menu diatas untuk aplikasi photoshop CC 2019 

akan dijelaskan sebagai beriku: 

1) File adalah berfungsi untuk menyimpan, membuka, input 

gambar/import atau output gambar/export serta cetakan. 

2) Edit adalah berfungsi untuk menyalin (copy), memotong 

(cut) atau menempel (paste) gambar juga berisi tentang 

fungsi mengatur editing gambar. 

3) Image adalah berfungsi untuk editing gambar, warna serta 

mengatur ketajaman warna. 

4) Layer adalah berfungsi untuk membuat tampilan berlapis-

lapis seperti menghapus layer, menambahkan layer serta 

menambahkan efek mauppun maksing untuk gambar. 

5) Select adalah berfungsi untuk menyeleksi gambar 

6) Filter adalah berfungsi pada aplikkasi untuk 

menambahkan efek yang sesuai dengan ke inginan. 

7) View adalah berfungsi untuk menampilkan dalam bentuk 

ukuuran besar atau kecil zoom dan skala (sroll + Alt). 

8) Window adalah berfungsi untuk mengatur tampilan dari 

aplikasi tersebut. 

9) Help adalah berfungsi untuk memberikan tampilan 

petunjuk penggunakan dari aplikasi tersebut. 

 

b). TOOL OPTION BAR 

 

 
Gambar 2.3 Tampilan Tool Option bar pada Photoshop CC 2019 
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Pada tampilan gambar diatas menunjukan kinerja aplikasi tool 

option dengan memiliki options untuk mengatur dari beberapa 

tool yang aktif yang digunakan tersebut. 

• TOOL BOX 

Dibawah tersebut akan dijelaskan dari beberapa fungsi 

masing-masing tool box yang terdapat pada Adobe 

Photoshop CC 2019. Fungsi-fungsinya dari tool box akan 

dijelaskan secara penggunaannya mempermudah untuk 

praktek. 

 

c). Palette Well 

Pada photoshop memiliki tool-tool sangat penting untuk 

penggunaannya yaitu palette well, dapat dilihat tampilan 

pakette Well adalah sebagai berikut tersebut. 

 
Gambar 2.4 Tampilan pakette Well pada Photoshop CC 2019 
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d). STATUS BAR 

 

Gambar 2.5 Tampilan status bar pada Photoshop CC 2019 
 

Tampilan status bar diatas merupakan informasi dari 

penggunakan dari aplikasi, salah satunya dengan memberikan 

infomasi tampilan gambar pada kanvas 200%. Untuk 

mempermudah kegiatan mendensain dengan teknik tersebut 

atau dengan cara melakukan klik pada mouse rolle tengah 

sambil tekan keyboard Alt otomatis dapat mengubah tampilan 

dalam bentuk 100% untuk tampilan kanvas dari aplikasi editing 

photoshop. Cara kerja ini memberikan kemudahan bagi semua 

khalayak umum untuk bekerja dibidang editing. Silahkan 

decoba dengan teknik tersebut.  

 

e). AREA KANVAS DOKUMEN 

 
Gambar 2.6 Tampilan area kanvas dokumen gambar pada 

Photoshop CC 2019 

 

Gambar area kanvas dokumen tersebut sangat penting karena 

digunakan untuk teknik editing dengan beberapa ukuran dari 
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area kanvas, proses ukuran dapat menyesuaikan dari 

penggunaannya. Fungsi lain digunakan untuk open gambar 

untuk pengolahan gambar dalam file baru. 

 

f). Navigation Palette Windows 

 

 
Gambar 2.7 Tampilan Navigation palette pada Photoshop CC 

2019 

Tampilan dari windows → navigator memiliki fungsi yang 

digunakan untuk memberikan informasi secara detail bagian 

dari gambar yang di editing dari segi warna maupun dari 

pemberian editing kecerahan warna. 

 

g). Warna Palette 

Fungsi dari warna palette sangat berperan untuk mengetahui 

atau mengisi dari warna tersebut salah satunya dengan nilai 

warna R G B dengan kebutuhan dengan batuan tools yang 
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(swatches) yang digunakan untuk merubah dari background 

atau latarbelakang. 

 

h). History Palette Tool 

  
Gambar 2.8 Tampilan Color palette pada Photoshop CC 2019 

 

Fungsi dari history palette tool digunakan untuk 

mengetahui kinerja untuk mengetahui dari proses 

penggunakan apliksi photoshop, jadi misalkan kita melakukan 

Undo dan Redo juga menambahkan brush atau pun mengubah 

tampilan text itu dapat dikembalikan dengan memilih dari tools 

tersebut 

 

i). Layer Palette history 
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Gambar 2.9 Tampilan Color palette pada Photoshop CC 2019 

 

Fungsi dari Layer palette history digunakan untuk 

mengetahui tamppilan yang dilakukan aktifitas atau kegiatan 

sewaktu menggunkan aplikasi tersebut. Dengan beberapa yang 

harus digunakan missal posisi awal dengan membuka dokumen 

baru pada kanvas seterusnya editing lalu melakukan simpan 

dokumen tentu semua akan terekan sendirinya dalam 

penggunaannya. Penggunakan yang penting misalkan 

melakukan kesalahan dapat dikembalikan kembali. 

 

 

C. PENGENALAN TOOLS 

Pada tool berikut adalah sangat berfungsi untuk proses 

operasi digunakan untuk melakukan desain yang sangat berguna 

dan memberikan tahapan dibidang editing gambar maupun foto. 

1. TOOLS 
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Gambar 2.10 Tampilan Color palette pada Photoshop CC 2019 

 

 

D. FUNGSI TOOL  

a. Edit Fill 

Edit fill digunakan untuk mengedit warna atau mengubah 

warna tersebut. Dengan cara meseleksi warnanya dengan 

menggunakan seleksi yang ada pada option window yang telah 

diatur. 

 

b. Edit Stroke 

Edit stroke digunakan untuk memberikan warna dalam bentuk 

garis, caranya tinggal masuk option didalam tampilannya. 
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c. Edit Transform 

Edit Transform yang digunakan untuk memutar dari layer suatu 

gambar yang mau diedit sesuai dengan keinginan. 

  
Gambar 2.11 Tampilan Transform show 

1) Scale : digunakan untuk memberikan teknik editing 

membesarkan atau mengecilkan suatu gambar didalam 

dokumen.  

2) Rotate : digunakan untuk rotasi atau gambar memutar 

sesuai keinginan  

3) Skew, distorsi, perspektif, warp : digunakan untuk 

membuat benda bisa diubah. 

4) Rotate 180 : berfungsi memutar dengan nilai 180 derajat 

dalam suatu gambar. 

5) Rotate 90 CW : berfungsi memutar searah jarum jam 

dengan nilai 90 derajat dalam suatu gambar. 

6) Rotate 90 CCW : berfungsi memutar berlawanan jarum 

jam dengan nilai 90 derajat dalam suatu gambar. 
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7) Flip horizontal : berfungsi mirior untuk membuat tampilan 

gambar menjadi Horizontal  

8) Flip Vertikal : berfungsi mirior untuk membuat tampilan 

gambar untuk menjadi Vertikal. 

 

d. Image Mode 

Mengubah dari system warna cahaya (RGB /Red, 

Green, Blue), (CMYK /Cyan Magenta Yellow dan Black) atau 

(RGB/Red, Green, Blue) 

 

e. Image Adjustment 

Tool yang sangat berperan untuk memberikan warna menjadi 

gelap ataupun memjadi teranga salah satunya dengan memilih 

menu Brightness-Contrast atau Hue-Saturation. 

 

f. Image Image Size 

Tools yang digunakan untuk mengubah tampilan gambar 

misalnya dari kecil ke bentuk besar atau dengan menekan tools 

transform. 

 

g. Image Canvas Size 

Tools yang berfungsi untuk mengubah tampilan dalam betuk 

potongan dalam suatu layer. 

 

h. Select Rotate Canvas 

Fungsinya digunakan untuk memutar atau merotasi suatu 

gambar yang sudah di edit dalam areanya. 
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i. Select Inverse 

Fungsi tools ini digunakan untuk menseleksi bagian dari 

gambar pada suatu layer dengan ketentuan selama gambar 

tersebut di editing. 

 

j. Select Feather 

Penggunakan dari tools Feather sangat penting karena 

memudahkan untuk editing seperti crop agar hasilnya pinging 

bias halus dan misalkan untuk editing gambar dalam bentuk 

pant hasil lebih nyata untuk tampilannya. 

 

k. View Effect 

Tool tersebut dapat dimanfaatkan untuk beberapa hal salah 

satunya untuk menampilkan filter yang bias kita gunakan untuk 

manipulasi gambar. 

 

l. View Ruler 

Untuk fungsi view ruler pada aplikasi sangat dibutuhkan 

misalkan untuk menampilkan ukuran dalam bentuk pixel 

gambar serta cm untuk bagian garis dan inches. Jadi sangat 

membantu melakukan editing tersebut salah satunya bagi 

editing desain biar tepat untuk menempatkan suatu garis 

tersebut. Untuk garis dengan warna biru muda tapi jika untuk 

dicetak tidak akan lihatan waktu hasilnya. 

 

m. View Snap Tools 
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Snap tools sangat berperan membantu karena dapat digunkan 

untuk membuat suatu gambar atau tampilan dengan 

memberikan kemudahan, misalkan untuk teknik editing 

mengubah tampilan gambar atau mengecilkan tampilan 

gambar jadi mudah dengan menyeret gambar ke suatu 

dokumen dengan bantuan garis biar lebih pas dan tepat 

sararan dari gambar tersebut. 

 

n. View Tools 

View Tools atau menampilkan tools dengan menekan menu 

windows view tools maka dapat menampilkan beberapa menu 

salah satunya layer, color, history dan brush serta banyak yang 

lain. 

 

Tujuan BAB II 

1. Mengetahui apa saja dari fungsi-fungsi tools dari aplikasi. 

2. Mengetahui dengan cara dari dasar tools yang paling terpenting dalam 

editing foto. 

3. Mengetahui teknik-teknik dari penggunaan tools tersebut. 

4. Mempermudah bagi yang masih awam dapat belajar dengan riel  

 

 

Kesimpulan  

Materi BAB II 

Pada materi bab II menyajikan secara lengkap untuk mengetahui 

dari area kerja baru dari adobe photoshop dan juga berisi tentang fungsi-

fungsi dari tools atau alat untuk mengedit foto yang telah ditentukan dari 

aplikasi tersebut. Disamping itu telah ditentukan tool yang paling 

terpenting didalam photoshop antara lain; Fill, Stroke, Transform, Mode, 

Adjustment, Canvas, Size, Inverse, Feather, Effect, Ruler dan Snap adalah 
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tool yang sering tiap penggunaanya selalu digunakan sebagai dasar 

editing. 

 

BAB III.  PEMBAHASAN PHOTOSHOP 

 

A. Cara Membuat Laman Kerja Baru  

Pembahan tutorial dalam buku tahapan awal tentang 

membuat halaman baru pada Photoshop CC 2019. Photoshop CC 

2019 yang tampilannya berbeda dibanding versi dibawahnya. Dalam 

membuat dokumen di CC 2019 tersebut, ada banyak pilihan 

pengaturan dan interface nya pun lebih enak dilihat dibanding 

photoshop versi dibawah nya. Salah satu nya adalah fitur Document 

Preset yang mampu menyimpan preset saat kita membuat dokumen 

baru, berikut tersebut adalah tutorial lengkap cara membuat laman 

kerja baru pada Adobe Photoshop CC 2019 beserta penjelasan 

masing-masing fungsinya. 

1. Langkah Pertama dengan cara, masuk dahulu menu klik file → new 

atau dengan menekan tombol keyboard (ctrl+n) dengan 

mempermudah editingnya. Selanjutnya maka akan terbuka jendela 

baru yaitu New Document. 

 

Gambar 3.1 Tampilan New Document 

2. Langkah kedua memberikan beberapa artenatif pemilihan dokumen 

baru dengan ukuran kertas yang berbeda-beda. Pada jendela baru itu, 

silakan anda atur ukuran, color mode, dan lainnya dan jika sudah 
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silakan klik Create (jangan Close ). Nah bagi yang masih bingung, apa 

saja maksud dari fitur-fitur new document tersebut, berikut tersebut 

adalah penjelasannya. 

 
Gambar 3.2 Tampilan bank document presets 

a). Document Preset , yang bisa kita gunakan untuk memilih preset 

yang sudah ada, seperti ukuran kertas, warna, dan lainnya sudah 

tersedia disitu. 

b). Preset Details, berfungsi untuk memberi nama dan menyimpan 

preset sobat. 

c). Size , berfungsi untuk mengatur ukuran pada laman kerja tersebut 

(termasuk orientasi, serta resolusi nya). 

d). Color Mode, berfungsi untuk mengubah mode warna pada 

document yang dibuat. 

e). Background Contents, berfungsi untuk mengatur warna pada latar 

belakang (Background). 

f). Advanced Options , berisi pengaturan lanjutan seperti profile 

warna contohnya. 

g). Create & Close, Create berfungsi untuk membuat laman kerja 

baru tersebut sedangkan close untuk membatalkannya (menutup 

jendela new document). 

 

 

 

B 

C 

D 

E 

F 

G 

A 
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B. Fitur Terbaru Adobe Photoshop CC 2019 

Photoshop untuk Versi 2019 menawarkan peningkatan 

pada fitur yang ada seperti Isi Sadar Konten dan Layar Beranda, 

serta alat baru seperti Alat Bingkai dan pratinjau Blend Mode 

dinamis. Ia bahkan menambahkan sesuatu yang seharusnya 

dimiliki selama ini: Roda Warna. Symmetry Mode, yang 

merupakan beta teknis di versi terakhir, sekarang telah diterapkan 

sepenuhnya, memungkinkan Anda melukis sapuan kuas dalam 

pola simetris. 

Penyempurnaan antarmuka, seperti menyesuaikan ukuran 

font dengan kontrol aplikasi, membuat pengalaman lebih kohesif. 

Satu klik di Preferensi menskalakan bilah alat, ikon, tombol, label, 

dan panel menurut ukuran jenis kecil - kecil, sedang, dan besar. 

Dalam hal ini efek dari aplikasi tersebut memiliki vitur yang paling 

digunakan seperti Camera RAW filter yang terbaru untuk editing 

foto. Maka kita bahas beberapa fitur yang paling penting didalam 

pengeditan foto antara lain. 

1. Fitur Shake Reduction 

Fitur untuk aplikasi Photoshop secara otomatis 

menganalisis wilayah gambar yang paling sesuai untuk 

pengurangan guncangan, menentukan sifat keburaman, dan 

mengekstrapolasi koreksi yang sesuai ke seluruh gambar. Gambar 

yang dikoreksi ditampilkan untuk tinjauan anda di dialog 

Pengurangan Goyang lakukan dengan cara dengan cara Buka 

gambarnya. Pilih Filter> Sharpen> Shake Reduction. 

a) Langkah awal masuk pada aplikasinya dengan klik dan pilih 

open > file, dapat ditunjukkan gambar dibawah tersebut. 
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Gambar 3.3 Tampilan open foto 

Untuk tampilan diatas akan muncul diawal setelah klik pada 

aplikasinya. Selanjutnya dengan memilih file foto untuk membuat 

dan mengedit foto tersebut. 

 

 

b) Selanjutnya pilih foto yang mau di edit dengan klik open 

 
Gambar 3.4 Tampilan Open 

c) Setelah itu muncul gambar yang mau di edit pada dokumen 
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Gambar 3.5 Tampilan foto dokumen baru 

d) Selanjutnya langsung dicoba menggunakan perintah klik Tool 

Shake Reduction selanjutnya mengklik tampilan pada 

toolbar ditunjukkan Filter→Sharpen→Shake Reduction. 

 
Gambar 3.6 Tampilan filter 

 

 

e) Terakhir untuk menghasilkan gambar yang mau diedit dari 

yang brur menjadi lebih halus dapat pilih peraturannya  

dengan memilih Trace Bound, Smoothing dan Artifact 
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Suppression, Artifact Suppression selanjutnya dengan pilih OK, 

dapat dilihat hasilnya sebagai berikut tersebut. 

 
Gambar 3.7 Tampilan preview shake reprodution 

  

2. Focus Area 

Focus Area digunakan sebagaimana untuk menempatkan 

titik fokus, yang dapat memberikan tambahan dalam dunia editing 

salah satunya menerapkan teknik menyeleksi memotong dan 

memindahkan objek ketempat kanvas tersebut. Aplikasi 

photoshop untuk pengembangannya telah banyak cara untuk 

meningkatkan beberapa hal yang dapat memberikan kinerja pada 

suatu editing. Focus area telah memudahkan semua pihak 

enditing salah satunya ada pada penggunaan pen tool yang sering 

digunakan untuk menyeleksi sesuai dengan keinginan kita. 

Tahapan selanjutnya untuk editing memudahkan jika masuk 

kedalam focus area, adapun cara atau langkah-langkah dapat 

ditunjukan dibawah ini. 

a) Langkah awal dengan melakukan cara buka gambar pilih file → 

Open pilih gambar yang disesuaikan dengan foto masing-

masing. Langkah selanjutnya klik dua kali untuk membuka 

gemboknya pada suatu layer tersebut. 
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Gambar 3.8 Tampilan Open Image 

b) Langkah kedua pilih klik Select>Focus Area. 

 
Gambar 3.9 Tampilan Focus Area 

c) Langkah selanjutnya atur dari menu focus area dengan 

memilih refine adge serta berikan nilai 3,00. Dapat ditunjukan 

sebagai berikut ini. 
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Gambar 3.10 Tampilan dialog Focus Area 

d) Tahapan selanjutnya dengan memilih beberapa hal yang perlu 

diubah salah satunya Smooth, Feather, Contrast, Shift Edge 

dan Amount dapat diatur dari niainya serta ubah dari view 

mode ke dalam On White dengan cara brush untuk melakukan 

menghapus.  

 
Gambar 3.11 Tampilan dialog properties 

e) Selanjutnya pillih clear selection maka akan seperti dibawah 

tersebut. 
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Gambar 3.12 Tampilan clear selection 

f) Ubah tampilan menjadi back and waite, digunakan tahapan 

penyeleksian pada gambar 

 
Gambar 3.13 Tampilan back and waite 

g) Pilih layer mask pada outputnya digunakan untuk merubah 

tampilan dengan menghilangi background dengan masking jadi 

tanpa menghilangi aslinya. Apabila sudah merasa cukup klik ok. 
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Gambar 3.14 Tampilan layer mask 

h) Hasil akhir dari teknik menghilangi background adalah sebagai 

berikut. 

 
Gambar 3.15 Tampilan menghilangi background 

 

3. Perspective Warp 
Dalam penerapan di mana subjek gambar besar, seperti 

bangunan, distorsi yang memperpendek dapat terjadi karena 

sudut fotografer dalam hubungannya dengan bangunan tersebut. 

Fitur Perspective Warp di Photoshop memungkinkan Anda 

meluruskan gambar untuk mengurangi beberapa distorsi. 

Langkah-langkah berikut menunjukkan cara membuatnya tampak 
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seolah-olah gambar diambil dari sudut yang lebih datar. Caranya 

melakukan mengklik menu toolbar Edit → Perspective Warp atau 

Klik di salah satu sudut bidang kiri kedua yang akan terhubung ke 

bidang pertama dan seret hingga garis biru muncul di sepanjang 

tepi penghubung bidang tersebut. Sorotan biru menunjukkan 

bahwa tepi yang terdeteksi dapat digabungkan. Jika sorotan 

berwarna kuning atau merah, bidang tidak terhubung dan Anda 

perlu menyesuaikan posisi sudut penghubung. Seret setiap sudut 

bidang kisi yang tersisa agar sejajar dengan sudut yang tampak 

pada permukaan bangunan yang berdampingan. 

a) Langkah pertama dengan mengedit gambar mobil dapat pilih 

menu → open selanjutnya klik menu tool Perspective Warp  

ditunjukkan sebagai tersebut. 

 
Gambar 3.16 Tampilan open gambar 

 

b) Klik seleksi tool (magictools) untuk menyeleksi bagian yang akan 

dihapus backgroundnya.  
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Gambar 3.17 Tampilan open magictools 

c) Langkah selanjutnya menghapus background dengan cara 

menekan tombol delete. 

 
Gambar 3.18 Tampilan delete background 

 

d) Langkah selanjutnya dengan menekan tombol Edit>Perspective 

Warp, dapat ditunjukan gambar sebagai berikut. 
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Gambar 3.19 Tampilan Perspective Warp  

e) Tahapan selanjutnya dengan menekan gambar pada posisi 

empat titi dengan cara diklik baru di sesuaikan ukurannya.  

 
Gambar 3.20 Tampilan edit Perspective Warp  

f) Dengan cara klik Alt dengan ditahan dan klik dengan mouse 

yang perlu diubah bentuknya. 



51 
 

Desain Grafis (KREASI EFEK PHOTOSHOP CC) 

 

 
Gambar 3.21 Tampilan gambar menyesuaikan Perspective Warp   

g) Pilih open gambar jalan raya untuk memberikan background 

dari mobil tersebut 

 
Gambar 3.22 Tampilan open gambar   

h) Selanjutnya dengan menambahkan shadow atau banyangan 

agar gambar lebih nyata dilihat. 
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Gambar 3.23 Tampilan penggabungan dengan banyangan   

 

4. Menu RAW filter 
Perkembangan aplikasi dari editing foto tentunya dalam 

Plug-in Adobe Camera Raw, digunakan untuk mengubah gambar 

RAW menjadi piksel yang dapat dipahami Photoshop, adalah 

editor yang sangat kuat namun mudah digunakan. Namun 

demikian, jika Anda tidak memotret dalam format RAW, Anda 

mungkin tidak berpikir untuk menggunakannya. Di kolom ini, Anda 

akan mempelajari tujuh alasan untuk memanggil filter Camera 

Raw di Photoshop CC. 

Pertama, siapkan gambar untuk menggunakan filter 

Camera Raw secara tidak merusak. Pilih File> Buka sebagai Smart 

Object atau, jika gambar terbuka dan memiliki satu lapisan, pilih 

Filter> Convert for Smart Filters. Untuk dokumen multilayer, klik 

layer atas untuk membuatnya aktif, Shift-klik layer bawah untuk 

memilih semuanya, lalu pilih Filter> Convert for Smart Filters. 

Photoshop menyelipkannya ke dalam pembungkus pelindung 

objek pintar. Selanjutnya, pilih Filter> Camera Raw Filter di versi 

Photoshop CC mana pun. Setelah Anda menutup filter, Anda 

dapat membuka kembali dialognya dengan mengklik dua kali 

namanya di panel Layers. Dalam hal editing foto salah satunya 

foto prewidding maupun wedding tersebut ada beberapa point 

yang bisa kita atur nilainya seperti berikut ini: 



53 
 

Desain Grafis (KREASI EFEK PHOTOSHOP CC) 

 

a) Langkah pertama ambil gambar prewedding dengan caca 

mengatur filter masuk filter terus klik Camera Raw Filter 

 
Gambar 3.24 Tampilan Open gambar  

b) Langkah selanjutnya klik Filter>Camera Raw Filter digunakan 

mengubah warna pada suatu foto. 

 
Gambar 3.25 Tampilan menu filter  

Tahapan selanjutnya dengan memberikan beberapa poin yang 

harus diatur tone color nya antara lain: 

a) exposure  
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b) Contrast 

c) Highlight 

Memberikan warna menjadi lebih halus, tajam juga bisa bernoise 

erta dapat juga vignete, susuai dengan keinginan editingnya untuk 

tahapannya. 

 

 
Gambar 3.26 Tampilan tone color 

c) Atur sesuai dengan selera anda masing masing untuk 

pewarnaannya. 

 
Gambar 3.27 Tampilan Camera Raw pewarnaan 
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d) Hasil akhir dari warna yang telah diberikan suatu filter Camera 

Raw Filter 

 
Gambar 3.28 Tampilan Camera Raw Filter 

 

Tujuan BAB III 

1. Mengetahui cara membuat kanvas baru atau New Dokumen dengan 

ukuran yang sudah ditentukan 

2. Mengetahui cara mengatur cahaya agar lebih lembut dan membuat 

tampilan agar lebih fokus tanpak pada foto 

3. Mengetahui teknik-teknik dari seleksi atau cara menghapus warna 

background dengan tambahan automatis lebih cepat dan mudah untuk 

proses editing 

4. Mengetahui tambahan effect terbaru dari camera raw filter 

 

 

Kesimpulan  

Materi BAB III 

Pada materi bab III selanjutnya ada tambahan yaitu fitur 

terbaru dari Adobe Photoshop CC 2019 memberikan filter raw untuk 

mempermudah editing foto terutama bagi editing wedding dan 

prewedding. Pada Photoshop CC 2019  mempunyai beberapa kelebihan 

dari fitur terbarunya. Tahapan efek raw sangat memuaskan didalam foto 

editing tersebut.  
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Kemudahan dalam editing foto dapat memberikan kepuasan 

sendiri apalagi bila mana ada suatu foto mau dibuat hasilnya lebih halus 

dalam suatu foto, hasilnya juga membuat lebih tajam juga bisa bernoise 

serta dapat juga vignete, semuanya dapat dilakukan dengan 

menggunakan Adobe Photoshop CC karena fitur tersebut memudahkan 

eding suatu gambar. 
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BAB VI  EFEK PHOTOSHOP 

 

A. Tutorial efek kulit terkupas 

Pada tutorial untuk menghasilkan efek tambahan dengan 

menambahkan brush. Caranya tinggal unduh aja diinternet dengan 

mengklik hasilnya dari unduhan lalu mengektraknya kedalam suatu 

drive masing-masing, dapat masuk drive c lalu masuk adobe kemudian 

masuk adobe photoshop masuk folder presets pilih brushe dapat 

copykan didalammnya. 

1) Langkah awal dapat dibuka terlebih dahulu brush nya yang sudah di 

extrak kedalam drive. 

 
Gambar 4.1 Tampilan Instal Brush Real Smoke 

2) Setelah extrak ke dalam drive masuk adobe photoshop masuk 

folder presets pilih brushe dapat copykan didalammnya, urutannya 

sebagai berikut. 

a) Drive C Program File  

b) Adobe  

c) Adope Photoshop CC  

d) Presets  

e) Brushes 



58 
 

Desain Grafis (KREASI EFEK PHOTOSHOP CC) 

 

 
Gambar 4.2 Tampilan Instal Brush Real Smoke > copy 

 

3) Langsung di paste kan kedalam Presets > Brushes 
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Gambar 4.3 Tampilan Instal Brush Real Smoke > paste 

 

4) Selanjutnya buka adobe photoshop CC 2019, silahkan open atau 

buka gambar muka yang akan diedit, dapat ditunjukan gambar 

dibawah tersebut.. 

 
Gambar 4.4 Tampilan open > image 

 

5) Teknik selanjutnya dari open gambar langkah sebagai berikut. 

 
Gambar 4.5 Tampilan open gambar 
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6) Langkah selanjutnya atur dari level nya atau dengan pilih keybord 

dengan menekan (ctrl+l) dapat juga dengan meklik pada menu 

image → adjustments → levels dapat ditunjukan gambar dibawah 

tersebut. 

 

Gambar 4.6 Tampilan menu Image > Adjustment > Levels  

7) Tahapan langkah selanjutnya dengan membuatkan move tool 

dengan klik dan drag gambarnya kedalam dokumen kanvasnya. 

Selanjutnya dengan memberikan gambar model dijadikan satu 

kedalam layer gambar yang sudah dikunci. Untuk gambar dinding 

yang retak dimasukkan kedalam satu gambar sama modelnya. 
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Gambar 4.7 Tampilan open > image  

 

8) Selanjutnya dengan pilih gambar tersebut yang telah dimasukkan 

kedalam satu layer dan pilih gambarnya serta klik Tarik gambar 

kedalam full area gambar atau dokumen kanvas tersebut.  

. 

 
Gambar 4.8 Tampilan Penyesuaian Gambar  
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9) Langkah cara selanjutnya dengan menambahkan Color Dodge, pilih 

gambar layer atas sendiri dengan memindahkan mode ke dalam 

Color Dodge. Hasilnya dapat ditunjukkan sebagai berikut ini. 

 

 
Gambar 4.9 Tampilan Color Dodge 

 

10) Setelah hasilnya sudah mendekati seperti rusak maka dengan 

menambahkan eraser tool untuk menghapus dari gambar agar 

hasilnya lebih rapid dan halus. 

 
Gambar 4.10 Tampilan Eraser tool 

 

11) Hapus bagian-bagian yang tidak dipakai dengan erase tool. 
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Gambar 4.11 Tampilan gambar setelah di erase tool 

 

12) Selanjutnya dengan memilih gambar kayu yang rusak akan 

dimasukkan kedalam foto model yang sudah disiapkan. Jadi hasilnya 

biar model memiliki wajah yang sangat rusak parah dalam 

editingnya perlu gambaran ide. 
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Gambar 4.12 Tampilan gambar setelah di erase tool 

 

13) Selanjutnya klik ganbar yang terkupas tersebut dengan di drag ke 

posisi gambar tersebut. 

 
Gambar 4.13 Tampilan menyesuaikan gambar ke posisi 
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14) Membuat tampilan agar bisa menggabung menjadi satu gambar 

dari modelnya agar terlihat seperti terkupas dapat pilih mode pilih 

Linear Light, dapat ditunjukkan sebagai berikut.  

 
Gambar 4.14 Tampilan Linear Light 

 

15) tahapan selanjutnya untuk menghapus bagian gambar agar menjadi 

kulit terkupas dengan memilih Eraser Tool. Cara penggunaannya 

dengan cara klik layernya yang ada fotonya dengan klik sapu dengan 

bertahap. 

 
Gambar 4.15 Tampilan Eraser Tool  

 

16) selanjutnya dari beberapa teknik langkah-langkahnya maka hasilnya 

akan seperti tersebut . 
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Gambar 4.16 Tampilan hasil dari Eraser Tool  

 

17) hasil Sudah mulai menjadi wajah yang mengerikan, agar tidak 

terlalu banyak layer harus digabungkan menjadi satu layer. 

18) Langkah dari beberapa layer harus dijadikan satu dengan cara klik 

kanan pada layer-layer pilih klik merge visible, maka akan 

bergabung menjadi satu gambar dilayernya. 
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Gambar 4.17 Tampilan hasil dari Merge visible 

 

19) Tahapan selanjutnya membuat efek seperti air yang menetes, 

langkah awalnya dengan mempersiapkan gambar tembok dinding 

dengan pilih file → open. 

 
Gambar 4.18 Tampilan open gambar 

 



68 
 

Desain Grafis (KREASI EFEK PHOTOSHOP CC) 

 

20) Masukan gambar dinding kedalm gambar jadikan satu sama model, 

seperti cara diatas. 

 
Gambar 4.19 Tampilan open gambar dalam satu dokumen 

 

21) Selanjutnya dengan memilih mode menjadi Hard Light menjadikan 

gambar tembok dapat menjadikan menyatu dengan gambar model 

tersebut. hasilnya dapat ditunjukan gambar dibawah tersebut. 
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Gambar 4.20 Tampilan Hard Light 

 

22) Langkah selanjutnya dengan menghapus gambar tersebut dengan 

pilih menu Eraser Tool. Langkahnya dengan melakukan agar foto 

agak samar-samar dengan menghapusnya. 
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Gambar 4.21 Tampilan hasil sementara 

 

B. Tutorial Membuat Efek Kulit Terbakar dan Berasap 

1) Langkah pertama persiapakan gambar yang sudah kita edit 

sebelumnya dengan file open gambar “Wajah rusak”  
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Gambar 4.22 Tampilan open gambar wajah rusak 

 

2) Selanjutnya dengan open gambar bara api yang sudah dipersiapkan 

sebelumnya. 

 
Gambar 4.23 Tampilan open api 
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3) Setelah open kedua gambar tersebut maka dijadikan satu dengan di 

drag ke jendela gambar wajah rusak. 

 
Gambar 4.24 Tampilan drag menjadikan satu dokumen 

 

4) Untuk menggabungkan kedua gambar tersebut dengan memilih 

pada layer screen. 
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Gambar 4.25 Tampilan layer screen 

 

5) Selanjutnya hasil pada layer screen adalah sebagai berikut tersebut, 

tinggal dihapus dengan erase tool. 
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Gambar 4.26 Tampilan erase tool 

 

6) Agar hasilnya lebih menarik hapuslah pada gambar api dengan 

erase tool, hasilnya dapat disesuikan sebagai berikut tersebut. 
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Gambar 4.27 Tampilan hasil erase tool 

 

7) Langkah selanjutnya membuat efek asap yang sudah kita bahas 

untuk instalansi brush smoke, dalam penyelesannya yang pertama 

dengan pilih create a new layer setelah itu pilih size brush atau 

ukuran brush yang telah di tentukan sebagai berikut tersebut. 
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Gambar 4.28 Tampilan hasil create a new layer > brush smoke 

 

8) Dengan memilih brush yang akan ditentukan dengan gambar 

tersebut yaitu dengan memilih brush real smoke. 
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Gambar 4.29 Tampilan hasil pilih brush smoke 

 

9) Setelah dari brush real smoke telah ditentukan maka tinggal 

menyesuikan ukurannya dengan size 2197 px sebagai berikut 

tersebut. 
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Gambar 4.30 Tampilan ukuran brush smoke 

 

10) Pilih color picker dengan memilih warna putih yang akan digunakan 

untuk membuat hasil dengan warna putih. 

 

 

 
Gambar 4.31 Tampilan color picker 

 

11) Hasil yang sudah diberikan brush real smoke, anda bisa 

menyesuuikan mana yang akan diberi efek asap tersebut. Hasil 
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akhir dari editing menggunkan efek asap adalah sebagai berikut 

tersebut. 

 

 
Gambar 4.32 Tampilan hasil dari brush real smoke 

 

C. Tutorial efek Dark Art dengan Photoshop 

1) Pertemuan berikut tersebut akan membahas tentang pembuatan 

foto dark art dengan photoshop. Efek tersebut terkesan agak 

menakutkan atau lebih seperti horror sering kalinya efek dart 

untuk membuat beberapa poster dari film maupun poster untuk 

majalah. Didalam pertemuan tutorial akan dibahas beberapa cara 

dari teknik pembuatannya.  

2) Model wanita atau bias diganti dengan foto anda, bahan awalnya 

bias dilihat dibawah tersebut. 
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Gambar 4.33 Tampilan gambar model 

 

3) Masukkan bahan Tekstur tanah yang retak atau pun dapat dengan 

yang lain, bahannya gambar tanah retak seperti berikutnya. 
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Gambar 4.34 Tampilan gambar tanah retak 

 

4) Pilih file open untuk mengambil gambar yang sudah disediakan, 

dapat dilihat sebagai berikut tersebut. 
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Gambar 4.35 Tampilan file open 

 

5) Selanjutnya pilih duplicade layer yang digunakan sebagai copy an 

dari yang asli dari background, karena jika ada kerusakan gambar 

kita masih mempunyai gambar aslinya. 
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Gambar 4.36 Tampilan duplicade layer 

 

6) Selajutnya dengan memilih menu Create a new layer dengan cara 

diletakkan diatas layer pertama. 
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Gambar 4.37 Tampilan Create a new layer 

 

7) Selanjutnya dengan memilih Clone Stamp Tool digunakan untuk 

men stempel dengan cara klik pada objek yang lain trus pindahkan 

ke objek sasaran dari stampnya caranya tekan Alt pada keyboard. 

8) Lakukan cloning pada bagian mata. Cara untuk melakukan cloning 

adalah sebagai berikut: 

9) Penggunaan dari cloning dengan menutup mata denga cara antara 

lain 

− Dengan cara mengatur Clone Stamp Tool pilih brush dengan 

ukuran kecil dapat menekan pada keyboard “[“ sedangkan 

untuk membesarkan dengan tekan “]” pada keyboard. 

− Setelah itu dapat menekan Alt sambal menekan gambar mata 

dan mengambil sampel gambar pada posisi yang lain.  

− Selanjutnya dengan pilih brush sapukan ke bagian mata dari 

gambar tersebut. Buat stamp lakukan dengan berulang sampai 

seluruh gambar mata tersebut. 
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Gambar 4.38 Tampilan clone stamp tool 

 

10) Dari pembahasan teknik clone dapat dilihat hasilnya dari meng-

clone adalah seperti gambar berikut tersebut. 
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Gambar 4.39 Tampilan clone stamp tool kedua mata 

  

11) Hasil sementara dari tahapan clone dapat dilihat sebagai berikut 

tersebut. 

 

 

Gambar 4.40 Tampilan hasil clone stamp tool 
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12) Selanjutnya dengan menambahkan foto tanah tekstur tanah retak 

dengan pilih menu Ctrl + O untuk membah gambar. 

 
Gambar 4.41 Tampilan open tanah retak 

 

13) Langkah selanjutnya dengan menambahkah gambar dan klik drag 

pada foto tanah retak dan dimasukkan kedalam canvas. Untuk 

mempersiapkan gambar dengan klik drag suatu gambar tersebut 

menjadikan satu. 

14) Masukkan gambar tanah retak diatas gambar modelnya yang 

digunakan untuk menutupi foto model tersebut. 
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Gambar 4.42 Tampilan Move Tool (V) 

 

15) Langkah teknik selanjutnya dengan memberikan mode kedalam 

Multiply,yang dilakukan untuk memberikan gambar agar menjadi 

gambar menjadi satu. Gambar dapat ditunjukkan sebagai berikut. 
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Gambar 4.43 Tampilan Multiply 

 

16) Selanjutnya untuk hasil gambar untuk editing sebagai berikut. 
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Gambar 4.44 Tampilan hasil sementara 

 

17) Langkah berikutnya memberikan efek warna hitam tinggal 

menambahkan Gradient map, dengan cara pilih menu dan tekan 

icon yang bernama Create new fill → adjustment layer 

selanjutnya pilih menu Gradient Map. Dapat ditunjukkan 

gambarnya sebagai berikut. 
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Gambar 4.45 Tampilan Gradient Map 

18) Hasil sementara dari penambahan Gradient Map dapat dilihat 

seperti dibawah tersebut. 

 
Gambar 4.46 Tampilan hasil sementara 

 

19) Selanjutnya beri tulisan dengan klik text tool dan ketik efek foto 

dark art 
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Gambar 4.47 Tampilan horizontal type tool (T) 

 

20) Dan hasil akhir dapatkan dari beberapa teknis adalah seperti 

berikut tersebut. Semoga bermaanfaat dari teknik-teknik effect 

dark art. 

 
Gambar 4.48 Tampilan effect dark art 

 

D. Tutorial Efek Teks Logam  

1) Tutorial efek teks dengan menambahkan tulisan dalam bentuk 

logam. Untuk pembuatan efek tersebut dengan menambahkan 

beberapa element didalam efeknya. 
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2) Langkah selanjutnya siapkan dokumen baru dengan ukuran 

kurang 800x600 pixel dengan resolusi 72 pixel. Tetapi bisa 

menggunakan ukuran sesuai dengan keinginan seperti A4 maupun 

kertas A3, untuk hasilnya dapat dilihat sebagai berikut. 

 

 
Gambar 4.49 Tampilan costum 800×600 

 

3) Langkah selanjutnya pilih tool (text tool) dengan memilih font 

dengan font arial dengan ketebabalan serta untuk besarnya 48pt. 

 
Gambar 4.50 Tampilan ukuran font 

 



94 
 

Desain Grafis (KREASI EFEK PHOTOSHOP CC) 

 

4) Pilih font yang kiranya lebih tegas dan kokoh jadi pemilihan font 

tidak dibatasi, untuk hasilnya dapat ditunjukkan sebagai berikut. 

 
Gambar 4.51 Tampilan pilihan font 

 

5) Selanjutnya dengan menambahkan efek filter → stylize → emboss 

dengan memberikan teknik atau bisa diberikan efek emboss 

tersebut kedalam textnya. 
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Gambar 4.52 Tampilan Filter > Stylize > Emboss 

 

6) Selanjutnya anda atur dari emboss nya dengan ketentuan sebagai 

berikut tersebut. 

 
Gambar 4.53 Tampilan peraturan Emboss 
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7) Untuk membuat efek seperti gambar logam dengan pilih menu 

Filter → Artistic → Plastic Warp¸ serta sesuaikan dengan 

penggunaan efek tersebut. 

 
Gambar 4.54 Tampilan peraturan Emboss 

 

8) Tampilan dari Plastic Warp adalah sebagai berikut tersebut. 

 
Gambar 4.55 Tampilan peraturan Plastic Warp 

 



97 
 

Desain Grafis (KREASI EFEK PHOTOSHOP CC) 

 

9) Selanjutnya pilih pada image → Adjustments → Curves, dengan 

menampilkan gambar suatu warna atau mengatur warna 

kecerahan dari gambar tersebut. Secara langkah-langkahnya 

dalam pembuatan kurva warba dapat dilihat caranya sebegai 

berikut. 

 
Gambar 4.56 Tampilan image > Adjustments > Curves 

 

10) Tampilan dari curves untuk merubah tampilan warna dapat dilihat 

sebagai berikut. 

 
Gambar 4.57 Tampilan peraturan Plastic Warp 
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11) Selanjutnya mengulangkan warna dari tahapan sebelumnya 

dengan teknik kurva atau bisa tekan tombol (ctrl+v), hasilnya 

sebagai berikut. 

 
Gambar 4.58 Tampilan peraturan Curves 

 

12) Langkah selanjutnya menampilkan background dengan warna 

hitam agar gambar dari text logam dapat kelihatan lebih utuh dan 

lebih menyatukan lebih jelas. Utuk hasil akhirnya gambar untuk 

olahannya dari tahapan sebelumnya ditunjukkan sebagai berikut. 

 
Gambar 4.59 Tampilan gambar background 
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E. Tutorial Efek Brush Asap 

Tahapan dari tutorial selanjutnya membahas efek brush asap, 

silahkan untuk mempersiapkan bahan dengan foto model atau foto 

apa saja yang penting sesuai. Dalam mempersiapkan teknik tersebut 

untuk membuat efek asap dengan mengubah dari gambar tersebut. 

1) Langkah utama dengan mempersiapkan dukumen baru atau 

kanvas baru dengan ukuran bisa 600 x 500px denan memasukkan 

warna fillnya dengan background warna hitam. 

 

Gambar 4.60 Tampilan Open image 

2) Selanjutnya dengan membuat efek sketsa dengan cara memilih 

menu Filter→Stylize→ Find  pilih menu Edge.  

3) Tahapan selanjutnya denga menambahkan gambar model dengan 

mengubah warnanya hitam putih tekniknya dengan cara pilih 

menu Image → Adjusment→ Desaturate atau dapat dengan 

menekan tombol (Ctrl+Shift+U). untuk langkah-langkahnya dapat 

ditunjukkan tekniknya sebagai berikut. 
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Gambar 4.61 Tampilan Image>Adjusment>Desaturate  

4) Hasil sementara dari Image>Adjusment>Desaturate seperti 

dibawah tersebut 

 
Gambar 4.62 Tampilan hasil sementara 

5) Selanjutnya memberi efek filter dengan pilih filter > filter gallery 

dapat ditunjukkan dibawah tersebut.  
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Gambar 4.63 Tampilan filter > filter gallery 

6) Dari pemberian efek filter maka akan keluar dialog kotak dapat 

pilih stylize > growing edges > ok dapat dilihat seperti dibawah 

tersebut. 
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Gambar 4.64 Tampilan growing edges 

 

7) Cara selanjutnya untuk membuat efek dengan pilih menu 

Filter→Blur→Gaussian Blur, untuk memberikan effek blur pada 

gambar sketsa tersebut. 

 

 
Gambar 4.65 Tampilan menu Gaussian Blur  

8) Atur dari gaussian blur dengan radius 4,2 lalu pilih OK 
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Gambar 4.67 Tampilan Gaussian Blur  

9) Untuk meningkatkan kecerahan dari gambar dapat ditambahi 

dengan pilih adjustments > levels seperti dibawah tersebut. 

 
Gambar 4.68 Tampilan menu adjustments > levels 

10) Hasil dari tampilan levels dengan ketentuan input levels ( 8 : 1,04 : 

240) klik OK, seperti dibawah tersebut. 
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Gambar 4.69 Tampilan levels 

11) Selanjutnya pada layernya anda duplicade layer. 

 
Gambar 4.70 Tampilan duplicade layer 

12) Agar hasilnya sempurna maka sebagian harus dihapus dengan 

menggunakan tools > magic wand Tool (W). 
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Gambar 4.71 Tampilan tools > magic wand Tool 

13) Setelah hasilnya terseleksi maka dengan menambah feather 

dengan cara pilih select > modify > feather. 
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Gambar 4.72 Tampilan modify > feather 

14) Selanjutnya tekan pada keybroadnya dengan delete maka yang 

terseleksi akan terhapus semuanya seperti dibawah tersebut. 

 
Gambar 4.73 Tampilan hasil delete background 

15) Selanjutnya memilih background untuk belakang dari gambar 

tersebut maka dengan memilih layer lalu pilih menu filter > clouds  

16) Untuk membuat Ilustrasi gambar semakin kuat, kita akan 

menambah sedikit efek Cloud pada gambar. Buat lah layer tepat di 

atas Background (beri nama Clouds). dengan warna Foreground 

dan Background dalam keadaan Default yaitu Hitam dan Putih. 

(Tekan D) untuk membuat warna jadi default. kemudian Pilih 

Filter>Render>Clouds maka seperti dibawah tersebut. 
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Gambar 4.74 Tampilan Filter>Render>Clouds 

17) Hasil sementara pemberian dari efek background clouds tersebut. 

 
Gambar 4.75 Tampilan background clouds 

18) Selanjunya dengan memberi efek screen dengan cara pilih layer 

kedua lalu pilih screen dan yang kedua juga sama pilih layer 3 dan 

pilih efek screen. 
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Gambar 4.76 Tampilan screen 

19) Hasil yang setelah pemberian efek screen sebagai berikut 

tersebut. 

 
Gambar 4.77 Tampilan hasil sementara efek screen 
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20) Penambahan efek brush dengan memilih brush smoke dengan klik 

pada bagian gambar yang anda beri efek tersebut. 

21) Selanjutnya tambahkan dari brush asap tersebut kedalam suatu 

gambar. Tentkan dari opacity dengan 100px , dengan mulai 

melakukan sapuan brush kegambar bagian kepala sampai seperti 

gambar sebagai berikut. 

 
Gambar 4.78 Tampilan menambahkan Brush 

 

22) Langkah selanjutnya dengan mengatur efek asap dengan memilih 

Wrape  caranya klik pada Menu→Edit→Transform→Wrap. 

23) Klik pada tool brush dengan memposisikan brushnya atau dengan 

menginstal brush smoke pada aplikasinya. Jadi bisa mendowlod 

dari interner terlebih dahulu untuk membuatnya brush smoke 

nya. Maka tekniknya dapat dilihat sebagai berikut. 
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Gambar 4.79 Tampilan brush smoke 

24) Selanjutnya pilih layer 0 dengan menambah masking pada layer 

tersebut. 

 
Gambar 4.80 Tampilan masking pada layer 0 

25) Yang kedua untuk layer 1 juga biberikan masking guna untuk 

pemberian efek agak gelap pada gambar. 
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Gambar 4.81 Tampilan masking pada layer 1 

 

26) Selanjutnya dengan efek gradient dengan memilih menu layer 

mask seterusnya Gradient → Radial → Background to 

Foreground. Tarik warnanya dengan klik dari kanan ke kiri. 

 

 
Gambar 4.82 Tampilan Gradient editor 
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27) Langkah selanjutnya membuat komposisi warna dengan memilih 

menu Gradient Color → Ltersebutear, dapat ditunjukkan sebagai 

berikut. 

 
Gambar 4.83 Tampilan teknik efek Gradient 

28) Langkah selanjutnya dengan menekan dengan mouse klik dari 

ujung kiri kedalam ujing kanan pada gambar sampai kelihatan 

seperti garis, membuat warna gradasi pada suatu gambar. 
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Gambar 4.84 Tampilan Gradient editor 

29) Selanjutnya dengan klik drag tahan dengan klik dari bawah keatas 

pojok dengan diagonal 

 
Gambar 4.85 Tampilan efek Gradient dengan diagonal 

30) Cara selanjutnya membuat warna agak transparan dengan teknik 

pilih mode Overlay  dengan nilai opasitinya menjadi 75% dengan 

hasilnya dapat dilihat sebagai berikut. 
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Gambar 4.86 Tampilan Overlay  

31) Hasil akhirnya adalah sebegai berikut tersebut. 

 
Gambar 4.87 Tampilan hasil akhir 
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F. Tutorial Desain Kaos dengan Efek Multiply 

Tahapan tutorial kali ini akan membahas pembuatan desain 

kaos dengan Efek Multiply, yang kiranya kita bisa melihat beberapa 

kaos dengan desain yang cukup mewah dan sangat berkualiatas dari 

gambar-gambar seperti yang akan kita bahas adalah gambar naga yang 

akan kita buat dalam desain kaos tersebut. Mari kita bersama-sama 

membuat dengan teknik-teknik tutorialnya.  

1) Pertama-tama untuk tahapannya dengan membuat dokumen 

kanvas baru dengan ukuran pixelnya (800pixel x 600pixel) dapat 

ditunjukan sebagai berikut. 

 
Gambar 4.88 Tampilan dokumen baru 

 

2) Selanjutnya open gambar yang sudah ada yaitu gambar kaos 

sebagai berikut tersebut. 
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Gambar 4.89 Tampilan open gambar 

 

3) Tampilan dari open gambar kaos yang sebelumnya dibahas. 

 
Gambar 4.90 Tampilan open gambar kaos 

4) Selanjutnya anda seleksi dengan memilih tool sebalah kanan pilih 

magic selection 



117 
 

Desain Grafis (KREASI EFEK PHOTOSHOP CC) 

 

 
Gambar 4.91 Tampilan magic selection 

5) Setelah itu anda memindah seleksinya pada bagian didalam 

dengan pilih inverse, dapat dilihat sebagai berikut tersebut. 
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Gambar 4.92 Tampilan inverse 

 

6) Pilih pada new > layer via copy yang digunakan untuk memindah 

kopyan ke dalam layer baru. 

 
Gambar 4.93 Tampilan new > layer via copy 

 

7) Selanjunya anda melakukan draging pada dokumen baru yang 

sudah dipersiapkan. 
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Gambar 4.94 Tampilan draging pada dokumen 

 

8) Selajutnya dengan klik pada gambar kaos yang berada pada layer 

1 yang nantinya digunakan untuk duplikade menjadi dua gambar. 

 
Gambar 4.95 Tampilan duplikade 

9) Pilih pada gambar trus anda klik kanan pilih duplicade layer dapat 

dilihat sebagai berikut tersebut. 
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Gambar 4.96 Tampilan duplicade layer 

 

10) Selanjutnya anda membuat level pada gambar kaos dengan cara 

pilih gambar kaos lanjutkan dengan pilih Adjusments > level dan 

anda atur sesui kebutuhannya. 
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Gambar 4.97 Tampilan Adjusments > level 

 

11) Tampilan dari level dapat anda masukkan nilai kriterianya degan 

input level ( 0 : 1 : 70 ) dapat anda lihat sebagai berikut tersebut. 

 
Gambar 4.98 Tampilan level 

 

12) Selanjutnya dengan pilih Multiply pada gambar kaos layer 1 copy 

dapat dilihat dibawah tersebut. 
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Gambar 4.99 Tampilan Multiply pada gambar 

 

13) Pilih menu file > open gambar naga selanjutnya klik OK 
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Gambar 4.100 Tampilan file > open gambar 

14) Tampilan dari hasil open dari gambar naga dapat diihat sebagai 

berikut tersebut. 
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Gambar 4.101 Tampilan open dari gambar naga 

 

15) Selanjutnya dengan memilih magic tool untuk memberikan seleksi 

pada gambar tersebut. 
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Gambar 4.102 Tampilan magic tool 

 

16) Pilih inverse yang digunakan dalam penyekeksian ditengah dari 

objek tersebut. 
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Gambar 4.103 Tampilan inverse 

 

17) Setelah selesai kita inverse pada gambar tersebut maka degan 

memilih copy, dapat dilihat sebagai berikut tersebut. 
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Gambar 4.104 Tampilan copy 

 

18) Klik pada menu edit paste maka memindahkan dari gambar 

sebelumnya ke tempat yang baru. 
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Gambar 4.105 Tampilan edit paste 

 

19) Hasil pemindahan gambar setelah di copy dan di paste kan pada 

dokument yang sudah disiapkan untuk kaos tersebut. 

 
Gambar 4.106 Tampilan hasil penggabungan 

 

20) Langkah selanjutnya dengan menghapus bagian gambar naga 

dengan erase tool. 
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Gambar 4.107 Tampilan menu erase tool 

 

21) Hasil sementara yang sesudah dihapus bagian dengan erase tool 

adalah sebagai berikut tersebut. 

 
Gambar 4.108 Tampilan hapus bagian gambar naga 

 

22) Pilih pada layer –layer yang akan digabungkan dengan seleksi trus 

klik kanan pilih merge layer, dapat dilihat sebagai berikut 

tersebut. 
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Gambar 4.109 Tampilan merge layer 

 

23) Berikut tersebut adalah hasil dari merge layer atau penggabungan 

layer per layer menjadi satu. 
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Gambar 4.110 Tampilan hasil merge layer 

 

24) Selanjutnya membuat stroke dengan pilih blending optiont > 

stroke bisa dilihat seperti dibawah tersebut. 

 
Gambar 4.111 Tampilan blending optiont > stroke 

 

25) Pilih layer style dengan memilih stroke dengan warna merah dan 

klik OK 
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Gambar 4.113 Tampilan warna stroke 

 

26) Hasil sementara yang telah diberi stroke pada gambar kaos 

tersebut 

 
Gambar 4.114 Tampilan hasil sentara 

 

27) Pilih warna biru muda yang akan digunakan untuk memberikan 

pada background kaos tersebut 
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Gambar 4.115 Tampilan color picker 

 

28) Pilih paint bucket tool dengan menuangkan warna biru muda 

pada layer background. 

 
Gambar 4.116 Tampilan paint bucket tool 
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29) Hasil sementara yang telah diberi stroke pada gambar kaos 

tersebut 

 
Gambar 4.117 Tampilan hasil pemberian background 

 

30) Selanjunya pilih drop shadow yang digunakan untuk background 

pada kaos tersebut. 

 
Gambar 4.118 Tampilan menu drop shadow 

 
31) Pilih layer style dengan memilih multiply dan tekan OK 
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Gambar 4.119 Tampilan layer style drop shadow 

 

32) Hasil akhir yang sudah selesai dari beberapa penggunaan teknik 

dari pembuatan kaos. 

 
Gambar 4.120 Tampilan hasil akhir dari kaos 
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G. Tutorial Efek Foto Mozaik  
Tutorial yang akan disampaikan dengan tema foto mozaik, foto 

mozaik adalah foto yang disusun dari beberapa foto yang ukurannya kecil-

kecil. Teknik pembuatannya dengan menggunakan menu define pattern. 

Proses pembuatan dengan cara mengatur foto-foto menjadi sama, adapun 

teknik yang digunakan menyusun foto harus dengan menyusun yang rapi an 

lebih baik untuk tampilannya. Dibawah akan dijelaskan beberapa langkah-

langkah teknik untuk membuat foto mozaik, silahkan dapat simak tutorialnya. 

  

 

Gambar 4.121 Tampilan hasil efek define pattern 

 

1) Langkah awal siapkan beberapa foto yang harus di masukkan 

kedalam suatu layer. Foto yang disiakan kurang lebih dari sepuluh 

foto untuk dimasukkan kedalam layer. Proses pembuatannya foto 

harus berbeda-beda dari satu sama yang lain.  

2) Proses pembuatannya membuat dokumen kanvas baru 

(file→new) dengan membarikan nama pattern. 

3) Selanjutnya buat ukuran dengan ketentuan 1500 pixel X 1500 

pixels dengan ukuran kanvas tersebut dimasukkan foto-fotonya. 
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Gambar 4.122 Tampilan dokumen kanvas baru  

 
4) Tahapan awalnya dengan cara membuat garis horisontal dan 

vertikan (Guide Vertikal/horizontal) dengan cara memilih view → 
new guide dengan memilih ukurannya dengan mengisikan (12,5%) 
untuk tiap garisnya, jika sudah di setting klik OK. Untuk membuuat 
garis dalam bentuk vertikal dapat ditunjukkan gambar dibawah ini. 
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Gambar 4.123 Tampilan Buat Guide secara vertikal. 

5) Tahapan selanjutnya membuat garis new → guide dengan 

ketentuan posisi vertikan dengan mengisi 12,5% selanjutnya 

vertikan dengan mengisi 25% vertikan dengan mengisi 37,5% 

vertikan dengan mengisi 50%, vertikan dengan mengisi 62,5% 

vertikan dengan mengisi 75% serta vertikan dengan mengisi 

terakhir 87,5%. Dapat ditunjukkan gambar sebagai berikut. 
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Gambar 4.124 Tampilan Buat tujuh buah guide vertikal. 

 

6) Tahapan selanjutnya membuat garis horisontal new → guide 

dengan ketentuan posisi horizontal dengan mengisi 12,5% 

selanjutnya horizontal dengan mengisi 25% horizontal dengan 

mengisi 37,5% horizontal dengan mengisi 50%, horizontal dengan 

mengisi 62,5% horizontal dengan mengisi 75% serta horizontal 

dengan mengisi terakhir 87,5%. Dapat ditunjukkan gambar 

sebagai berikut. 
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Gambar 4.125 Tampilan Garis dokumen kanvas 

 

7) Tahapan langakah selanjutnya dengan pilih foto awal atau yang 

pertama dengan memilih file → place untuk mengambil fotonya 

posisikan foto agar bisa sama dengan garisnya. Tahapan tersebut 

buat beberapa foto untuk disusun kedalam dokumennya. 
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Gambar 4.126 Tampilan garis untuk foto 

 

8) Selanjutnya dengan menseleksi bagian foto dalam bentuk kotak 

atau (Rectangular Marquee Tool) selanjutnya dengan 

menekan Ctrl+J pada keyboard. Pilih klik kanan dan klik smart 

object foto. 

 
Gambar 4.127 Tampilan seleksi Tool 

9) Selanjutnya pilih layer 1 untuk memberikan foto-foto yang lain 
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Gambar 4.128 Tampilan kotak garis atau guide  

10) Langkah selanjutnya dengan meberikan duplikade layer dan 

memindahkan layer ke layer berikutnya, dengan keterntuan 

membuat layer baru. 
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Gambar 4.129 Tampilan smart object  

 

11)  Langkah selanjutnya dengan mengulangi bebrapa teknik langakah 

ke lima dengan mengisi beberapa gambar harus terpenuhi foto 

tersebut. Dapat dilihat tampilannya sebagai berikut. 
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Gambar 4.130 Tampilan dokumen dari Kanvas  

 

12) Tahapan selanjutnya dengan membuat efek foto Define Pattern 

Mozaik, adapun langkah-langkahnya dengan memilih menu Edit 

→ Define Pattern dengan menambahakan nama foto mozaik 

dengan tekan tombol klik OK selanjutnya dokumen tersebut 

simpan kedalam file dengan nama (pattern.psd) untuk filenya. 
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Gambar 4.131 Tampilan Pattern foto 

 

13) Langkah selanjutnya dengan membuat membuat efek foto Mozaik 

dengan cara kumpulkan semua foto-foto yang disiapakan 

selanjutnya masuk ke dalam menu Create a new layer foto-foto 

dengan membuat lebih kecil-kecil sesuai dengan kebutuhannya.  
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Gambar 4.132 Tampilan menambahkan layer 

 

14) Tahapan selanjutnya dengan pilih layer utama (1) dengan memilih 

menu fill → Pattern Mozaik caranya pilih menu drop down use 

selanjutnya dengan memilih pattern klik OK yang sudah dibuat 

sebelumnya dengan penggabungan foto-foto yang sudah 

disiapkan 
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Gambar 4.133 Tampilan menu Fill pattern 

 

15) Selanjutnya dengan memilih layer awal (1) dengan pilih menu 

Image → Adjustments → Desaturate teknik selanjutnya dengan 

mengubah menu mode menjadi Overlay, maka hasilnya dapat 

ditunjukkan gambar sebagai berikut ini. 
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Gambar 4.134 Tampilan  mengubah menu blend mode  

 

16) Teknik-teknik sebelumnya yang sudah dibahas dari beberapa 

tahapan maka hasinya adalah sebagai berikut. 

 
Gambar 4.135 Tampilan  hasil akhir  
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H. Tutorial foto Efek lukisan cat warna air 

Berikut ini adalah beberapa teknik untuk membuat efek lulisan 

cat air dengan menggunakan aplikasi Photoshop. Teknik tersebut 

dengan menggabungkan beberapa gambar tekstur dari cat air, teknik 

tersebut banyak ide dari kreatifiatas semua bila mana dapat banyak 

referensi dari mana pun dapat membuatnya. Silahkan simak sesama 

dari turotial dari penggunaan gambar-gambar menjadi satu gabugan 

dengan mengandakan teknik menu mode.  

 

 

Gambar 4.136 Tampilan hasil awal watercolor 

 

Langkah demi langkah dapat membuat teknik tersebut salah 

satunya silahkan dapat mengambil file yang sudah disiapka untuk 

editingnya atau manipulasi gambarnya. Untuk latihan dapat 

menggunakan foto yang anda miliki untuk latihannya. Mari kita mulai 

pembahan pada tutorial langkah nya sebagai berikut. 
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1) Langkah awal dengan membuka foto yang kita miliki dengan cara 

memilih pada menu selanjutnya klik File → Open, ambil fotonya 

dengan klik foto dan selanjutnya di klik tombol open. Hasil 

sementara sebagai berikut. 

 

 
Gambar 4.137 Tampilan open gambar  

 

2) Cara diawali dengan mengambil gambar tekstur yang sudah di 

siapkan dengan ketentuan untuk memasukkan dapat pilih file → 

open atau dengan file → place sama saja bedanya jika open 

berdiri sendri kalua place masuk pada gambar utama. Selanjutnya 

rapikan gambar dengan Free Transform pilih pada posisi kota jika 



151 
 

Desain Grafis (KREASI EFEK PHOTOSHOP CC) 

 

sudah sambil di drag atau diklik tekan tombol enter untuk 

menyelesaikan. 

 

 
Gambar 4.138 Tampilan mengambil file gambar  

 

3) Selanjutnya dengan cara  gambar dari yang sudah di masukkan 

agar dapat di sesuaikan ukurannya selanjutnya dapat dengan 

enter atau klik pada atas pojok dengan centang. 
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Gambar 4.139 Tampilan ukuran dan posisi file tekstur 

4) Dan seterusnya pilih dan ubah blend mode tekstur watercolor ke 

overlay. 
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Gambar 4.140 Tampilan menggunakan mode overlay 

 

5) Teknik selanjutnya dengan menambahkan gambar kedua bertema 

tekstur, caranya dengan pilih file → open atau dengan cara File 

→Place dengan mengubah pada menu blend modenya menjadi 

dalam bentuk Lighter Color. Tekniknya dapat ditunjukkan dibawah 

ini 
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Gambar 4.141 Tampilan mode normal  
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Gambar 4.142 Tampilan menambahkan lighter color 

 

6) Selanjutnya dengan menambahkan gambar ketiga bertema 

tekstur, caranya dengan pilih file → open atau dengan cara File 

→Place selanjutnya dengan mengatur ukuran dari dokumen 

kanvasnya dengan mengubah pada menu blend modenya menjadi 

dalam bentuk Color Burn. Tekniknya dapat ditunjukkan dibawah 

ini 
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Gambar 4.143 Tampilan mengubah Color Burn  

 

7) Selanjutnya dengan menambahkan gambar ketiga bertema 

tekstur, caranya dengan pilih file → open atau dengan cara File 

→Place selanjutnya dengan opacity ke 100% dengan mengubah 

pada menu blend modenya menjadi dalam bentuk Color Burn. 

Tekniknya dapat ditunjukkan dibawah ini 
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Gambar 4.144 Tampilan mengatur Color Burn  

 

8) Langkah selanjutnya dengan menambahkan gambar keempat 

bertema tekstur, caranya dengan pilih file → open atau dengan 

cara File →Place selanjutnya dengan mengubah ke dalam opacity 

ke 20% dengan mengubah pada menu blend modenya menjadi 

dalam bentuk Multiply. Tekniknya dapat ditunjukkan dibawah ini 
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Gambar 4.145 Tampilan Tambahkan tekstur keempat 

 

9) Langkah selanjutnya dengan atur blend modenya ke Multiply dan 

atur opacitynya ke 20%. 
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Gambar 4.146 Tampilan mengatur mode Multiply  

 

10) Langkah selanjutnya dengan menambahkan gambar kelima 

bertema tekstur, caranya dengan pilih file → open atau dengan 

cara File →Place selanjutnya dengan mengubah ke dalam opacity 

ke 20% dengan mengubah pada menu blend modenya menjadi 

dalam bentuk subtract. Tekniknya dapat ditunjukkan dibawah ini. 
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Gambar 4.147 Tampilan Tempatkan file tekstur kelima 

11) Selanjutnya dengan mengubah ke dalam opacity ke 20% menjadi 

blend mode →subtract. 
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Gambar 4.148 Tampilan mengubah opacity   

 

12) Selanjutnya teknik akhir hasil dari editing menggunkan file yang 

memiliki tekstur dari cat air dan menggabungkan dari beberapa 

teknik-teknik sebelumnya hal tersebut bahwa semuanya bisa 

diujicobakan dalam bentuk praktek mandiri, untuk hasil gambar 

dapat ditunjukkan sebagai berikut. 
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Gambar 4.149 Tampilan hasil akhir dari cat air   

 

Tujuan BAB VI 

1. Mengetahui dan mampu belajar teknik – teknik dari efek Adobe 

Photoshop CC 2019   

2. Mengetahui beberapa teknik efek yang dimiliki oleh Adobe Photoshop 

CC 2019   

3. Mengetahui lebih mudah dalam belajar efek karena dengan 

pembahasan yang jelas  

4. Mengetahui bahasan efek terbaru salah satunya  Efek watercolor 
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Kesimpulan  

Materi BAB IV 

Pada pembahasan diBAB VI tesebut adalah mengetahui dengan 

jelas cara Instal Brush (Real Smoke) yang digunakan sebagai efk Brush, 

karena brush banyak sekali jenisnya dalam macam-macam dari brush 

tersebut, dengan adanya efek brush menjadikan suatu gambar dapat 

nyata seperti aslinya. Pembahasan selanjutnya dengan efek Dark Art di 

Photoshop salah satunya penggabungan dua jenis gambar yang berbeda 

haya menambah Multiply sebagai hasilnya penggabungan gambar. Efek 

teks dengan tema hologram dengan sedikit tambahan efek stylize dan 

emboss jadi lebih mudah dalam pembuatannya. Photoshop lebih mudah 

dalam editing salah satunya dari Efek Foto Mozaik dengan Define Pattern 

adalah efek yang sudah terkenal dan dengan mudah dalam pembuatannya 

haya dengan teknik define pattern. Dalam pembahasan terakhir bab VI 

yang baru dengan membuat affek warna air atau cat air yang di 

emeplemantasikan pada editing serta dengan menggunakan teknik 

tersebut foto editing seperti lukisan air. 
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BAB V.  Manipulasi Pada PHOTOSHOP 

 

Manipulasi adalah suatu kegiatan bagi seseorang dalam bentuk 

rekayasa ataupun dengan menambahkan sesuatu yang unik dan 

menyatukan unsur estetika lebih nyata dengan memadukan kreatifitas 

atau ide seseorang yang dituangkan dalam bentuk gambar maupun dalam 

bentuk yang lain. Salah satu yang mempunyai bakat seni bias digunakan 

serta dapat di implementasikan kedalam suatu editing gambar atau 

mengedit pola digital. Pada pembahasan kali akan dibahas tutorial dengan 

beberapa teknik manipulasi dengan Adobe Photoshop CC 2019 adalah 

sebagai berikut tersebut. 

 

A. Tutorial Membuat Boneka KAYU  

1) Pada pertemuan berikutnya kita akan membuat efet manusia 

kayu dengan beberapa tahapan yang disiapkan antara lain 

adalah foto model,  dengan cara pilih File > Open pilih material 

foto model bisa dilihat sebagai berikut. 

 
Gambar 5.1 Tampilan File > Open 

 

2) Hasil sudah di open trus dokumen foto tersebut di duplicade 

dilayer 2 atau background copy. 
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Gambar 5.2 Tampilan duplicade 

 

3) Untuk memberikan warna pada foto tersebut klik pada 

background copy, klik pada keyboard (Ctrl + L) digunakan untuk 

meningkatkan level warna biar lebih kontras, bisa bilihat 

dibawah tersebut. 

 
Gambar 5.3 Tampilan level 
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4) Teknik selanjutnya pilih pen tool pada layer 2 dengan menyeleksi 

bagian foto dan untuk layer 1 di non aktifkan mata layernya. 

 
Gambar 5.4 Tampilan menyeleksi 

 

5) Langkah selanjutnya dengan memberikan warna yang lebih pilih  

image > adjustment > hue/saturation atau dengan (Ctrl + U). 

 
Gambar 5.5 Tampilan image > adjustment > hue/saturation 
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6) Hasil untuk perubahan warna dengan menambah layer 1 untuk 

dimasukkannya warna tersebut. 

 
Gambar 5.6 Tampilan perubahan warna 

 

7) Selanjutnya dengan menyeleksi bagian gambar lutut tersebut 

dengan meduplikade ke layer 1, lebih jelasnya bisa dilihat 

sebagai berikut tersebut. 

 
Gambar 5.7 Tampilan meduplikade ke layer 1 
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8) Memberikan ketajaman pada warna yang sudah diberi 

saturation dengan menyeleksinya dengan pilih klik background 

copy sama menekan keyboard + Ctrl.  

 
Gambar 5.8 Tampilan seleksi pada background copy 

 

9) Klik pada layer style dengan pilih layer background dengan pilih 

layer style pilih Drop Shadow (applay Drop Shadow effect ). 

 
Gambar 5.1 Tampilan layer style Drop Shadow 
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10) Pada langkah selanjutnya dengan menyeleksi lutut kiri dengan 

pilih pen tool trus klik kanan pilih make selection. 

 
Gambar 5.9 Tampilan  klik kanan make selection 

 

11) Menyeleksi akan muncul box make selection dengan feather 

radius 0 pixels > klik OK. 

 
Gambar 5.10 Tampilan feather radius 

 

12) Atur untuk duplikade dengan pilih edit copy, digunakan 

memberikan menggandakan suatu selection pada gambar. 
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Gambar 5.11 Tampilan copy 

 

13) Untuk memberikan warna yang sesuai maka bisa ditambahi 

dengan pilih Image > Adjudment > Hue/saturation. 

 
Gambar 5.12 Tampilan Image > Adjudment > Hue/saturation 

 

14) Selanjutnya atur warna yang telah dipilih hue/saturation klik ok, 

bisa dilihat sebagai berikut tersebut. 
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Gambar 5.13 Tampilan penentuan warna 

 

15) Hasil yang sudah dikasih warna sebagai berikut tersebut. 

 
Gambar 5.14 Tampilan seleksi warna 

 

16) Selanjutnya duplikade dari gambar yang telah terseleksi dengan 

menyamakan warna dengan pilih layer lalu klik kanan pilih copy 

Layer Style. 
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Gambar 5.15 Tampilan copy Layer Style 

 

17) Hasilnya dari copy Layer Style trus dilakun pilih layer yang beda 

pilih klik kanan lalu klik paste layer style, hasilnya sebagai 

berikut. 

 

 
Gambar 5.16 Tampilan paste layer style 
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18) Senjutnya pilih tools atau pent yang digunakan untuk menyeksi 

bagian yang akan diseleksi, pilih gambar lalu pilih make 

selection, hasil sebagai berikut. 

 

 
Gambar 5.17 Tampilan make selection 

 

19) Buat layer potong 3 untuk melakukan duplikade dari seleksi 

tersebut. 
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Gambar 5.18 Tampilan duplikade 

 

20) Selanjutnya pilih bevel & emboss bisa klik bagian pada blending 

options. Hasil akan kita lihat sebagai berikut tersebut. 

  
Gambar 5.19 Tampilan blending options 
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21) Langkah yang sama duplikade pada teknik sebelumnya dan 

masukkan pada layer baru. Seterusnya anda seleksi bagaian 

lututnya. 

 
Gambar 5.20 Tampilan seleksi 

 

22) Hasilnya biar sama maka pilih pada objek layer yang telah di 

seleksi dan paste pada bagian layer yang baru langkah bisa 

diikuti sebagai berikut. 

   
Gambar 5.21 Tampilan copy dan paste 
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23) Hasil sementara setelah diberikan effect dan agar sesuai dengan 

gambar sampinnya maka pilih bagian yang sesuai dan hasinya 

sebagai berikut tersebut. 

 
Gambar 5.22 Tampilan hasil sementara 

 

24) Selanjutnya lakukan dengan memberikan Make selection 

dengan pilih OK, seperti cara sebelumnya. 
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Gambar 5.23 Tampilan Make selection 

 

25) Dari hasil pemotongan dengan memberikan warna yang 

dominan dapat ditunjukan gambar dibawah tersebut.. 

  
Gambar 5.24 Tampilan memberikan warna 



178 
 

Desain Grafis (KREASI EFEK PHOTOSHOP CC) 

 

 

26) Hasil sementara sehabis diberi effect brush maka sebagai barikut 

tersebut. 

 
Gambar 5.25 Tampilan effect brush 

  

27) Pilih gambar yang telah tersedia digunakan untuk melakukan 

pemotongan. 

 
Gambar 5.26 Tampilan gambar tali 
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28) Selanjutnya pilih dan seleksi bagian dari gambar yang telah 

tersedia tersebut lakukan pemotongan dan duplikade menjadi 

dua, lakukan dapat ditunjukan gambar dibawah tersebut. 

 
Gambar 5.27 Tampilan pemotongan tali 

 

29) Pilih object tali lalu duplicate layer dengan mengatur ukurannya 

disesuikan dengan presesi tangan dari gambar, bisa dilihat 

sebagai berikut. 

 
Gambar 5.28 Tampilan duplicate layer 
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30) Atur gambar dari tali yang sudah diduplicate layernya  

 
Gambar 5.29 Tampilan penggabungan kedua tali 

 

31) Selanjutnya agar seperti manusia kayu maka bisa dimasukkan 

gambar kayu dengan pilih File > Open > pilih gambar kayu, 

hasilnya sebagai berikut tersebut. 

 
Gambar 5.30 Tampilan open kayu 
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32) Pilih warna gradient untuk menghasilkan gambar agar kelihatan 

lebih nyata, bisa lihat dibawah tersebut. 

 
Gambar 5.31 Tampilan gradient editor 

 

33) Untuk memberikan gambar agar lebih menyatu pada gambar 

yang lain maka bisa pilih overlay. 

 
Gambar 5.32 Tampilan overlay 
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34) Hasil akhir setelah diberi Overlay, maka hasilnya sebagai berikut 

tersebut. 

 
Gambar 5.33 Tampilan hasil akhir sementara 

 

35) Dari beberapa teknik yang telah kita bahas maka hasil akhir 

sebagai berikut : 
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Gambar 5.34 Tampilan hasil akhir dengan shadow 
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B. Tutorial Membuat Manusia Robot  

1) Pada tutorial tersebut akan dibahas teknik manipulasi 

pembuatan manusia robot diantata lai yang pertama dengan 

drag foto asli ke worksheet photoshop, dapat ditunjukan gambar 

dibawah. 

 
Gambar 5.35 Tampilan open gambar awal 

 

2) Masukkan background gambar yang sudah disiapkan melalui 

menu open 
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Gambar 5.36 Tampilan menu open 

 

3) Tahapan selanjutnya dengan membuka gambar background 

untuk latar belakang yang digunakan untuk menempatkan posisi 

dibelakang gambar model, dapat ditunjukkan gambar sebagai 

berikut. 
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Gambar 5.37 Tampilan open background 

 

4) Brush hitam pada bagian bawah background agar nantinya 

model menjejak tanah (tidak terlihat melayang). 

 
Gambar 5.38 Tampilan pemberian brush 

 

5) Tambahkan  layer mask lalu masking gambar pada background, 

agar dapat ditunjukan gambar dibawah. 
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Gambar 5.39 Tampilan ukuran brush 

 

6) Beri efek irisan pada kaki dengan lasso tool dan brush agar 

dapat ditunjukan gambar. 

 
Gambar 5.40 Tampilan pemotongan dengan lasso tool 
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7) Hasilnya akan ditunjukkan teknik selanjutnya pada gambar 

sebagai berikut. 

 
Gambar 5.41 Tampilan hasil sementara 

 

8) Masukkan gambar tangan robot yang akan disatukan dengan 

gambar model dengan pilih file kemudian open. 

 
Gambar 5.42 Tampilan open 
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Desain Grafis (KREASI EFEK PHOTOSHOP CC) 

 

 

9) Pilih gambar tersebut dengan cara disatukan, selanjutnya 

dengan menekan (ctrl + klik)  gambar kemudian pilih open 

 
Gambar 5.43 Tampilan klik open 

 

10) Selanjutnya setelah pilih open maka gambar dari file sebelumnya 

akan muncul, dapat ditunjukan gambar dibawah tersebut. 

 
Gambar 5.44 Tampilan membuka gambar dokumen 
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Desain Grafis (KREASI EFEK PHOTOSHOP CC) 

 

11) Masking tangan besi pada lengan atas gambar model separti 

pada gambar dibawah. 

 
Gambar 5.45 Tampilan Masking tangan besi 

 

12) Beri efek pada besi yang sudah dimasking dengan buka blending 

options. 
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Gambar 5.46 Tampilan blending options 

 

13) Beri bayangan pada tangan besi dengan pilih drop shadow dan 

aturlah agar terlihat menyatu dengan gambar model. 

 
Gambar 5.47 Tampilan drop shadow 
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Desain Grafis (KREASI EFEK PHOTOSHOP CC) 

 

14) Lakukan hal yang sama pada kaki seperti pada langkah 

sebelumnya. 

 
Gambar 5.48 Tampilan penambahan pada kaki 

 

15) Tambahkan efek kulit terkelupas pada kaki dengan 

menggunakan lasso tool selection, dan tempatkan dapat 

ditunjukan gambar dibawah. 

 
Gambar 5.49 Tampilan lasso tool selection 



193 
 

Desain Grafis (KREASI EFEK PHOTOSHOP CC) 

 

 

16) Tambahkan titik hitam kecil dengan brush tool pada bagian kaki 

yang dibuat terkelupas untuk efek lubang. 

 
Gambar 5.50 Tampilan efek lubang 

 

17) Tambahkan gambar lampu pada bawah tenggorokan yang sudah 

digambari dengan brush dengan teknik masking. 
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Gambar 5.51 Tampilan perpotongan tenggorokan 

 

18) Tambahkan gambar besi pada leher yang sebelumnya sudah di 

brush hitam dengan teknik masking. 
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Gambar 5.52 Tampilan gambar besi pada leher 

 

19) Tambahkan gambar besi pada kulit terkelupas dapat ditunjukan 

gambar dibawah. 
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Gambar 5.53 Tampilan kulit terkelupas 

 

20) Tambahkan gambar besi dengan teknik masking pada kaki 

kanan. 
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Gambar 5.54 Tampilan gambar besi pada kaki kanan 

 

21) Tambahkan gambar besi dengan teknik masking pada kaki kiri. 
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Gambar 5.55 Tampilan gambar besi pada kaki kiri 

 

22) Beri efek kulit terkelupas pada masking pada dada gambar. 

 
Gambar 5.56 Tampilan terkelupas dapa dada 

 

23) Beri efek lubang pada kulit terkelupas dengan brush tool. 



199 
 

Desain Grafis (KREASI EFEK PHOTOSHOP CC) 

 

 
Gambar 5.57 Tampilan hasil sementara 

 

24) Agar gambar dan background menyatu, beri efek gradient map 

dengan membuka menu Image>adjustmen>gradient map. 
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Gambar 5.58 Tampilan menu gradient map 

 

25) Pilih tipe gradient map. Kita pilih dapat ditunjukan gambar 

dibawah. 

 
Gambar 5.60 Tampilan gradient map 
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Desain Grafis (KREASI EFEK PHOTOSHOP CC) 

 

26) Atur kapasitas gradient sesuka hati kalian,agar gambar terlihat 

menyatu dan hasil teknik terakhir akan dapat ditunjukan gambar 

dibawah tersebut. 

 
Gambar 5.61 Tampilan hasil teknik akhir 

 

  



202 
 

Desain Grafis (KREASI EFEK PHOTOSHOP CC) 

 

C. Tutorial Membuat Manusia Avatar 

1) Tahapan seanjutnya dengan membuat manusia avatar teknik 

dari manipulasi manusia avatar adalah sebagai berikut 

tersebut. Langkah awal open gambar model yang sudah 

disiapkan. 

 

Gambar 5.62 Tampilan open gambar model 

 

2) Pilih clone stamp tool yang digunakan untuk mengilangi 

lengkungan hidung agar kelihatan merata, tekniknya seperti 

berikut tersebut. 
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Gambar 5.63 Tampilan clone stamp tool 

 

3) Hasil dari pemberian clone stamp adalah sebegai berikut 

tersebut. 

 

Gambar 5.64 Tampilan clone stamp 

 

4) Selanjutnya pilih filter > liquly yang digunakan untuk membuat 

perubahan pada suatu objek tersebut. 
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Gambar 5.65 Tampilan menu liquly 

 

5) Pada liquly  dengan Klik icon sebelah kiri atas yang menyerupai 

telunjuk yang akan digunakan sebagai teknik merubah objek 

dari wajah model tersebut. 

 

Gambar 5.66 Tampilan klik liquly 

 

6) Setelah selesai untuk menyempurnakan maka klik OK, untuk 

mengakiri dari editingnya. 

 

Gambar 5.67 Tampilan liquly 

 

7) Langkah selanjutnya yaitu menyeleksi bagian wajah model 

dengan cara klik Tools yaitu Polygonal lasso Tool, yang sebagai 

berikut tersebut. 
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Gambar 5.68 Tampilan Polygonal lasso Tool 

 

8) Setelah pilih polygonal lasso tool lalu seleksi bagian dari foto 

yang diseleksi bagiannya dengan teknik sebagai berikut 

tersebut. 

 

Gambar 5.69 Tampilan polygonal lasso tool 
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Desain Grafis (KREASI EFEK PHOTOSHOP CC) 

 

9) Semua sudah terseleksi dari bagian gambar sampai terseleksi 

akhir maka dapat dilihat dibawah tersebut. 

 

Gambar 5.70 Tampilan seleksi 

 

10) Selanjutnya pilih pada image > Adjusments > Hue/Saturation 

atau (CTRL+B) seperti dibawah tersebut. 

 

Gambar 5.71 Tampilan menu image > adjusments > 

Hue/Saturation 
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11) Maka tampilan dari Hue/Saturation adalah sebagai berikut 

tersebut. Anda bisa menentukan dari nilai ukuran yang 

ditentukan sendiri atau dengan selera kita sendiri. 

 

Gambar 5.72 Tampilan dialog Hue/Saturation 

 

12) Setelah ditentukan dari Hue/Saturation maka dapat dilihat dari 

review tampilan tersebut, pilih tombol OK untuk melihat 

hasilnya. 

 

Gambar 5.73 Tampilan warna Hue/Saturation 
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Desain Grafis (KREASI EFEK PHOTOSHOP CC) 

 

13) Klik pada menu eraser tool yang digunkan sebagai salah satu 

untuk gambar atau objek agar terlihat rapi. Dapat dilihat 

sebagai berikut tersebut. 

 

Gambar 5.74 Tampilan menghapus dengan eraser tool 

 

14) Selanjutnya pilih bagian dari brush tool dengan ketentuan 

warna hitam agar untuk menyamakan gambar, dapat dilihat 

sebagai berikut tersebut. 

 

Gambar 5.75 Tampilan brush tool 
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15) Pilih selection tool lalu pilih bagian dari hidung model. 

 

Gambar 5.76 Tampilan selection tool 

 

16) Pilih warna biru muda dan tuangkan pada bagian yang sudah 

terseleksi sebagai berikut tersebut. 
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Gambar 5.77 Tampilan pemberian warna biru muda 

 

17) Selanjutnya pilih filter > blur > gausian blur dapat dilihat 

sebagai berikut tersebut. 
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Gambar 5.78 Tampilan 

 

18) Untuk membuat hasil kelihatan blur, dengan cara pilih filter > 

gaussian blur maka tampilannya adalah sebagai berikut 

tersebut. 

 

Gambar 5.79 Tampilan gaussian blur 

 

19) Selanjutnya dengan memilih klik kanan degan pilih wrap 

adalah sebagai berikut tersebut. 
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Gambar 5.80 Tampilan klik kanan warp 

 

20) Hasil setelah dipilih teknik warp, sebagai berikut tersebut. 

 

Gambar 5.81 Tampilan teknik warp 
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21) Selajutnya pilih klik kanan flip horisontal maka akan terlihat 

sebagai berikut tersebut, 

 

Gambar 5.82 Tampilan klik kanan flip horisontal 

 

22) Selanjutnya dengan memilih bagian laso tool yang akan 

digunakan untuk meyeleksinya. 

 

Gambar 5.83 Tampilan menu laso tool 

 

23) Klik bagian-bagian yang harus terseleksi dengan laso tool yaitu 

pada bagian are ujung hidung dan mulutnya. 
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Gambar 5.84 Tampilan laso tool 

 

24) Selanjutnya pilih erase tool yang digunakan untuk menghapus 

bagian dari yang sudah terseleksi, dapat dilihat sebagai berikut 

tersebut. 

 

Gambar 5.85 Tampilan eraser tool 
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25) Hapus bagian dengan erase tool sampai terlihat begitu rapi dan 

merata pada tampilan sebagai berikut tersebut. 

 

Gambar 5.86 Tampilan menghapus bagian bibir 

 

26) Selanjutnya pilih bagian dari menu filter > Liqufy sebagai 

berikut tersebut. 
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Gambar 5.87 Tampilan menu liquify  

 

27) Tampilan dari liquify adalah sebagai berikut tersebut. 

 

Gambar 5.88 Tampilan liquify 
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Desain Grafis (KREASI EFEK PHOTOSHOP CC) 

 

 

28) Pilih dari mata kanan dan kirinya dengan klik bagian matanya 

sehingga terlihat sebagai berikut tersebut. 

 

Gambar 5.89 Tampilan meratakan mata 

 

29) Hasil sementara dari perubahan mata sebagai berikut tersebut. 
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Gambar 5.90 Tampilan hasil sementara 

 

30) Selanjutnya pilih gambar mata dengan kita open dan masukkan 

jadikan pada gambar sebelumnya. 

 

Gambar 5.91 Tampilan open gambar 

 

31) Klik pada bagian selection tool oval posisikan pada gambar 

mata yang sudah di open tersebut. 
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Gambar 5.92 Tampilan selection tool oval 

 

32) Pilih gambar mata yang sudah diseleksi dan masukkan 

sesuaikan ukuran dengan sizenya dengan ketentuannya 

sebagai berikut tersebut. 

 

Gambar 5.93 Tampilan ukuran dari mata 

 

33) Hasil sementara penempatan dari mata ke dalam model pada 

layer yang sudah ditentukan sebagai berikut tersebut. 

 

Gambar 5.94 Tampilan presisi mata 
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34) Selanjutnya anda pilih erase tool yang digunakan untuk 

memberikan gabungan dari gambar mata dan penggabungan 

dari dari mata model, dengan dihapus tipis tipis pada 

permukaannya sebagiannya. 

 

Gambar 5.95 Tampilan hasil pemambahan mata 

 

35) Pilih open dan ambil gambar zebra untuk digunakan untuk 

menutupi wajah dari model tersebut. 

 

Gambar 5.96 Tampilan open gambar zebra 
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36) Setelah dari gambar zebra telah di open maka gambar tersebut 

harus ditentukan agar kelihatan lebih merata dengan teknik 

opacity dibuat menjadi 17% dan pilih multiply, maka akan 

terlihat sebagai berikut tersebut. 

 

Gambar 5.97 Tampilan teknik opacity 

 

37) Pilih erase tool yang digunakan untuk menentukan agar pada 

bagian dari backgroud belakang dibuat menjadi menghilang 

dengan dihapus, seperti dibawah tersebut. 
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Gambar 5.98 Tampilan menghapus dengan erase tool 

 

38) Selanjutnya dengan memberikan teknik warp yang akan 

digunakan sebagaimana untuk memberikan agar gambar 

menjadi lebih nyata atau real. 

 

Gambar 5.99 Tampilan klik kanan warp 
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39) Tampilah setelah dipilih teknik warp adalah sebagai berikut 

tersebut. 

 

Gambar 5.100 Tampilan teknik warp 

 

40) Hasil sementara dari teknik wrap  adalah sebegai berikut 

tersebut. 

 

Gambar 5.101 Tampilan hasil sementara 

 

41) Dupikade dari gambar zebra tersebut dan tematkan pada 

bagian badan dari modelnya. 
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Gambar 5.102 Tampilan Dupikade dari gambar zebra 

 

42) Setelah kita open gambar zebra maka seterusnya untuk 

menggabungkannya maka dengan ketentuan klik pada gambar 

zebra trus pilih pada layer > multiply dan buat dua buah 

gambar untuk layernya, atas dan bawah dapat dilihat sebagai 

berikut. 

 

Gambar 5.103 Tampilan layer > multiply 

 

43) Hasil akhir dari pemberian gambar yang telah diberikan efek 

multiply adalah sebegai berikut tersebut. 
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Gambar 5.104 Tampilan hasil akhir 
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D. Tutorial Membuat Manusia SUPER 

Pada penjelasan kali tersebut kami akan bahas membuat 

teknik-teknik membuat efek-efek dalam photosop yang terdiri dari 

efek text, mask, cropig background dan merge image hasilnya seperti 

berikut tersebut. 

 
Gambar 5.105 Tampilan hasil awal 

 

1) Pada teknik pertama dengan menyeleksi Obyek, dengan 

mengambil file gambar foto tersebut, dengan klik > file > open. 

Setelah hasil masuk ke dokumen baru selanjutnya seleksi obyek 

yang akan kita edit dan hapus backgraund nya hingga seperti 

gambar sebagai berikut. 
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Desain Grafis (KREASI EFEK PHOTOSHOP CC) 

 

 
Gambar 5.106 Tampilan seleksi background 

 

2) Langkah senjutnya mengganti latarbelakan atau background 

yaitu pilih magic tool. Penggatian Backgraund dengan cara 

menggantikan Backgraund yang gunakan kali tersebut adalah 

pemandangan kota pada malam hari, hasilnya sebagai berikut. 

 
Gambar 5.107 Tampilan magic tool 

 

3) Teknik selanjutnya dengan Efek Brush Buat layer baru dan 

letakkan layer baru di atas layer obyek. Selanjutnya buat efek 

brush dengan memilih brush yang seperti air 
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Gambar 5.108 Tampilan Brush 

 

4) Tangan Robot Buka foto tangan robot klik file > open, serta 

seleksi. Langkah tersebut seperti pada sayap, namun dalam 

langkah tersebut, kita harus kembali pada obyek dan menghapus 

tangan obyek sebelah kanan untuk diganti dengan tangn robot 

yang akan digabungkan pada gambar foto yang satunya. 
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Gambar 5.109 Tampilan open tangan robot 

 

5) Membuat muka robot atau Sayatan Muka, Penambahan sayatan 

pada muka obyek, dimaksudkan untuk menambah kesan bahwa 

obyek merupakan robot sungguhan. Lebih jelasnya dapat dilihat 

sebagai berikut. 

 
Gambar 5.110 Tampilan open bahan 

 

6) Hasil sementara dengan teknik diatas, dan penggabungannnya 

sebagai berikut. 
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Gambar 5.111 Tampilan hasil sementara 

 

7) Langkah senjutnya dengan Penambahan Senjata Biar Obyek 

terlihat lebih menarik pehatian para penikmat  maka tambahkan 

senjata. Klik file > open. 

 
Gambar 5.112 Tampilan open 

 

8) Klik pada magic tool dan seleksi bagian tadi senjata selanjutnya 

masukkan dengan move tool dan tentukan senjata tersebut 

berada dibawa dari model tersebut, seperti dibawah tersebut. 
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Gambar 5.113 Tampilan penggabungan gambar 

 

9) Memberikan tambahan efek pada Teks dan diberi filter untuk 

text tersebut agar kelihat lebih menarik. 

 
Gambar 5.114 Tampilan text 

 

10) Memberikan effek emboss dengan anggle -94, height 27 dan 

Amount 114% dengan ketentuan sebagai berijut. 
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Gambar 5.115 Tampilan Emboss 

 

11) Dalam teknik penambahan teks tersebut saya menggunakan 

filter Emboss dan Diffuse 

 

 
Gambar 5.116 Tampilan Diffuse 

 

12) Selanjutnya dengan teknik Marge Layers Gabungkan layer 

menjadi satu dengan marge layers 
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Gambar 5.117 Tampilan marge layers 

 

13) Langkah Terakhir supaya foto terlihat lebih serasi, dan real, atur 

vibrance, exprosure, levels dan brightness/contras. 

 

 
Gambar 5.118 Tampilan color vibrance 
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14) Mengatur warna agar tidak terlalu full color maka ditentukan 

terlebih dahulu. 

 
Gambar 5.119 Tampilan color  

 

15) Selanjutnya dengan menambah warna agar lebih kontras dari 

belakangnya yaitu sebagai berikut. 
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Gambar 5.120 Tampilan warna kontras RGB 

 

16) Atur warna didalam brignetsness contrast, yang nantinya nilai 

dari warna disesuikan agar kelihatan lebihnya dan menjadikan 

gambar lebih seperti aslinya. 

 
Gambar 5.121 Tampilan brignetsness contrast 
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17) Hasil akhir editing tersebut merupakan hasil yang sudah jadi 

tinggal disimpan dalam bentuk jpg. Dengan klik file > save as 

kedalalam gambar, hasil akhir dapat dilihat sebagai berikut 

tersebut. 

 
Gambar 5.122 Tampilan hasil akhir 
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E. Tutorial Membuat The Hypnotical Moors 

Efek pada gambar kali tersebut akan dibahas unsur-unsur 
penggabungan yang dimiliki oleh Photosop CC 2019, hasil yang di 
inginkan akan seperti berikut tersebut. 

 
Gambar 5.123 Tampilan hasil awal 

 

1) Hypnotical Moors dari beberapa gabungan gambar. Landcape 

bacground Moors dibuat dari gambar air terjun sebagai berikut 

adalah bahan utamanya. 
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Gambar 5.124 Tampilan bahan gambar air terjun 

 

2) Bahan yang kedua selain air terjun, landscape background 

Moors juga ditambahkan unsur pohon agar memberi kesan 

Moors adalah tempat tersembunyi dan tidak semua orang dapat 

menemukannya. Moors adalah tempat khayalan yang tidak 

mudah dijangkau oleh orang yang tidak punya imajinasi. 
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Gambar 5.125 Tampilan bahan gambar hutan 

 

3) Air terjun dan hutan, bahan senjautnya yang ke tiga mengganti 

air kolam air terjun agar terlihat lebih dramatis dengan gambar 

air yang lebih bergelombang tetepi dengan unsur warna yang 

hampir sama agar terlihat menyatu dan tidak seperti gambar 

yang hanya ditempel. 

 
Gambar 5.126 Tampilan bahan gambar air 
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4) Pada bahan yang ke empat dengan unsur center atau ditengah 

tengah, memilih manipulasi sosok bidadari dari gambar wanita 

berkebaya. Wanita berkebaya putih melambangkan keanggunan 

yang murni dan suci, seperti mahluk fantasi bidadari yang 

melambangkan kecantikan, kesucian, keanggunan dan kesan tak 

tersentuh serta tidak mudah di jangkau. Gambarnya bisa dilihat 

seperti dibawah tersebut. 

 
Gambar 5.127 Tampilan bahan model bidadari 

 

5) Sebagai tambahan untuk brush agar lebih terlihat dramatis 

tambahkan beberapa brush yang download,yaitu: 

a). Brush Flower Corner 

b). Brush Wings 

c). Brush Sparkle 

d). Brush Soft Circle 

6) Dibawah tersebut salah satunya Brush Wings dan Brush Sparkle 

yang nantinya digunakan sebagai brush tambahan pada 

photosop, sebelum digunakan lebih baiknya brush tersebut 
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harus di instal terlebih dahulu dimasukkan pada software 

photosop. 

 

 
Gambar 5.128 Tampilan Brush Wings dan Brush Sparkle 

 

7) Menggunakan beberapa teknik manipulasi yang sudah dipelajari 

dan beberapa teknik yang ditentukan dengan menggunakan 

beberapa tools sederhana dalam toolbar Antara lain adalah 

teknik masking, teknik Clone stamp, brush dan Blending options. 

8) Langkah awal dengan open beberapa bahan yang sudah 

disiapkan, dengan klik file > open. 

 
Gambar 5.129 Tampilan open 4 gambar 
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9) Setelah di open akan muncul semua dari gambar-gambar yang 

tersedia sebagai dasar awalnya. 

 
Gambar 5.130 Tampilan open bidadari 

 

10) Tahapan selajutnya seleksi pada gambar bidadari tersebut 

dengan menghilangi gambar background nya. 
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Gambar 5.131 Tampilan seleksi gambar bidadari 

 

11) Masukkan yang sudah terhapus background nya kedalam 

background waterfall, berikut tersebut hasil seleksi. 
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Gambar 5.132 Tampilan seleksi background 

 

12) Posisikan dengan merotasi pada gambar bidadari tersebut, maka 

bisa kita lihat sebagai berikut tersebut. 

 
Gambar 5.133 Tampilan rotasi gambar bidadari 

 

13) Masukkan gambar hutan jadikan satu sama layer 1, dengan 

ketentuan sebagai berikut. 
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Gambar 5.134 Tampilan layer 1 gambar hutan 

 

14) Langkah selanjutnya dengan menggunakan teknik masking, 

dengan menggunakan teknik brush sebagai berikut. 

 
Gambar 5.135 Tampilan teknik brush 

 

15) Hasil tahapan awal teknik masking dan Clone stamp yang sudah 

menghasilkan yang cukup sempurna. 
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Gambar 5.136 Tampilan Clone stamp 

 

16) Masukkan teknik brush sudah ditentukan pada gambar tersebut 

agar kelihatan lebih hidup dan menarik pandangan pengihatan. 

 
Gambar 5.137 Tampilan teknik brush 

 

17) Selanjutnya dengan menambah seperti cahaya dan bintang-

bintang dengan teknik brush yang sudah ditentukan terlebih 

dahulu. 
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Gambar 5.138 Tampilan teknik brush 

 

18) Setelah penggunaan brush langkah selanjutnya dengan 

menggunakan efek warna dengan gradient map atau tekan 

ctrl+M sebagai berikut tersebut. 

 
Gambar 5.139 Tampilan gradient map 
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19) Biar hasinya warna lebih bernuangsa ke indahan dapat 

ditambahi dengan menggunakan Hue/Saturation untuk 

menyamakan satu warna. 

 
Gambar 5.140 Tampilan Hue/Saturation 

 

20) Hasil tahapan dari penambahan warna Hue/Saturation dan 

masking. 

 
Gambar 5.141 Tampilan hasil warna Hue/Saturation 

 

21) Agar warnanya lebih dominan menjadi teranga dan contras 

dengan menambah gradien map pertama dapat dilihat sebagai 

berikut tersebut. 
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Gambar 5.142 Tampilan gradien map 

22) Stelah dengan menambah gradien map pertama dapat 

ditambahi lagi dengan gradien map kedua yang dapat dilihat 

suasana malam hari. 

 
Gambar 5.143 Tampilan gradien map 

 

23) Terakhir kalinya setelah gradien map untuk memperjelas 

suasana butiran bintang-bintang dengan menambah Blending 
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options (outer glow dan inner glow) yang hasilnya agar lebih 

bercahanya. 

 
Gambar 5.144 Tampilan Blending options 

 

24) Hasil akhir dari teknik sebelumnya selanjutnya dengan 

menambahkan atau membuat teknik effek brush, dapat 

ditunjukkan gambar sebagai berikut. 

 
Gambar 5.145 Tampilan efek brush 

 

25) Setelah semua telah dijadikan satu dengan menggunakan merge 

image maka simpan dengan file > save as ke dalah format jpg. 

Hasil akhir yang sudah dalam bentuk JPG. Maka hasil akhir bisa 

dilihat dibawah tersebut. 
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Gambar 5.146 Tampilan hasil akhir 
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F. Tutorial Membuat Rumah Gelembung Dilangit 

Pada tutorial kali tersebut lebih membahas membuat 

gelembung yang berserta efek-efek yang lainnya, maka hasil yang 

akan dibahas adalah sebagai berikut tersebut. 

 
Gambar 5.147 Tampilan hasil  

 

1) Menyeleksi rumah dan batu agar pisah dari background menggunakan 

magic wand tool. Membuat gelembung dengan mempersiapkan kedua 

bahan batu dan rumah. 

 
Gambar 5.148 Tampilan bahan batu dan rumah  
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2) Bahan-bahan yang disiapkan untuk Pembuatan Rumah Gelembung 

Dilangit adalah sebagai berikut: 

a). Rumah  

b). gelembung 

c). langit 

d). batu 

e). balon udara 

f). rumput  

g). air 

3) Menggabungkan rumah, air, rumput dan batu dimasukkan kedalam 

gelembung menggunakan beberapa effek yang pertama dengan effect 

drop shadow selanjutnya menambahkan inner shadow juga masukkan 

inner glow serta bevel dan emboss pada penggabungannya. 

4) Langkah awal open terlehih dahulu dari bahan yaitu rumah dan 

gelembung air. 

 
Gambar 5.149 Tampilan open 

 

5) Hasil dari open sebagai berikut tersebut dengan mempersiapkan kedua 

gambar yang akan kita gabungkan. 
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Gambar 5.150 Tampilan air dan rumah 

 

6) Selanjutnya dengan menggunakan seleksi untuk menghilangi 

background dari rumah tersebut, serta digabungkan dengan 

menggunakan gambar batu dan rumah. 

 
Gambar 5.151 Tampilan batu dan rumah 

 

7) Hasil sementara dengan teknik masking yang pernah kita pelajari 

bersama untuk menggabungkan dengan masking dan cloning stam, 

digabungkan dengan background lagit. 
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Gambar 5.152 Tampilan background lagit 

 

8) Dari penggabungan yang sudah kita bahas dengan teknik masking, 

maka hasilnya sebagai berikut tersebut. 

 
Gambar 5.153 Tampilan penggabungan batu dan rumah 

 

9) Tahapan awal untuk penggabungan background dan rumah serta batu, 

dapat dilihat sebagai berikut tersebut. 
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Gambar 5.154 Tampilan background rumah serta batu 

 

10) Selanjuntnya membuat gelembung didalam penggabungan rumah 

tersebut. Dengan cara klik pada seleksi oval pilih dan sesuaikan pada 

posisinya. Pilih effect yang sudah tersedia seperti bevel dan emboss, 

inner shadow, inner glow dan drop shodow. Jadi memberikan effect 

gelembung yang nantinya diberi transparansi klik fill menjadi 0%. 

 
Gambar 5.155 Tampilan oval dan efek 
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11) Hasil dengan teknik yang telah dijabarkan pembuatan gelembung 

adalah hasilnya sebagai berikut tersebut. 

 
Gambar 5.156 Tampilan pembuatan gelembung 

 

12) Langkah selanjutnya dengan menduplicade atau menggandakan objeck 

yang sudah kita buat yaitu batu dan gelembung, di gandakan menjadi 

dua diposisikan sebelah kiri atas agar hasilnya lebih menarik. 

 
Gambar 5.168 Tampilan duplicade objeck 

 

13) Membuat lingkaran dan diberi warna pelangi opacity dikurangi dan 

diganti multiplay  
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Gambar 5.159 Tampilan warna pelangi opacity 

 

14) Untuk memperindah dilangit dengan menambah balon udara yang 

sudah ditentukan sebagai bahannya, dengan open gambar balon 

udara. 

 
Gambar 5.1 Tampilan open gambar balon udara 

 

15) Menggunakan clone stamp tool agar langit dan gelembung menyatu, 

effect outer glow dan balon udara dan diberi effect outer glow agar 

terlihat lebih bercahaya. 
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Gambar 5.170 Tampilan effect outer glow 

 

16) Menggunakan clone stamp tool agar langit dan gelembung menyatu, 

Menggunakan brush sprakle agar menyatu dengan langit. Untuk balon 

udara setelah diberi effect selanjutnya digandakan atau diduplicade 

menjadi enam dan diposisikan pada gambar langitnya. Lebih jelas bisa 

dilihat sebagai berikut tersebut. 

 

 
Gambar 5.171 Tampilan duplicade 
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17) Setelah hasil sudah selesai dan tidak ada perubahan maka dengan 

tersebut tinggal di simpan, pilih klik file > save as ke dalam jpg. Hasil 

akhir dapat dilihat sebagai berikut tersebut. 

 
Gambar 5.172 Tampilan Hasil akhir 
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G. Tutorial Membuat Water & Fire 

Dalam pembahasan kali tersebut dengan memberikan effet 

air dan text effect air, hasil yang akan kita bahas adalah sebagai 

berikut. 

 

 
Gambar 5.173 Tampilan awal dari hasil 

 

1) Pada pembuata awal open dari gambar tersebut dan dilakukan 

penyeleksian pada gambar, dapat diihat sebagai berikut tersebut. 
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Gambar 5.174 Tampilan open dari gambar 

 

2) Buka Objek yang akan kita edit, dan hapus background nya, dengan 

menggunakan seleksi magic tool hasilnya sebagai berikut. 

 
Gambar 5.173 Tampilan hapus background 
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3) Teknik selanjutnya dengan penggatian background gradasi warna 

transparan dan warna merah dengan cara klik pada gradient tool klik > 

drag pada backgroundnya. 

 
Gambar 5.174 Tampilan gradient tool klik > drag 

 

4) Penggantian Backgraund dengan foto awan dengan cara buka file foto 

awan atau dengan CTRL + O, kemudian masukkan foto ke dalam layer 

yang sedang kita edit, dan atur ukuran memenuhi background, setelah 

itu atur mode menjadi multiplay  

 
Gambar 5.175 Tampilan atur ukuran memenuhi background 
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5) Selanjutnya mengatur ketajaman warna untuk menyesuaikan warna 

antara objek dan beckgraund, atur ketajamannya dengan 

menggunakan Curves, Brightnes/contras, level dan sampai hingga 

diperoleh warna yang sesuai seperti berikut tersebut. 

 

 
Gambar 5.176 Tampilan Curves, Brightnes/contras, level 

 

6) Masukkan Brush efek air yang digunakan untuk mendapatkan efek air, 

selanjutnya dengan menambhkan efek brush tool agar memberikan 

effek air pada suatu gambar tersebut. 



265 
 

Desain Grafis (KREASI EFEK PHOTOSHOP CC) 

 

 
Gambar 5.177 Tampilan membuat efek air 

 

7) tambahkan Brush Efek api dengan tekniknya seperti efek air, tinggal 

diganti warnanya saja, buatlah brush semenarik mungkin sesuai 

keinginan kita. Dapat dilihat sebagai berikut tersebut. 

 
Gambar 5.178 Tampilan Efek api 
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8) Pilih Teks untuk digunakan nama atau judul, penambahan teks dengan 

warna putih hasilnya akan sebagai berikut tersebut. 

 
Gambar 5.179 Tampilan nama atau judul 

 

9) Hasil akhir dengan Efek Logam dengan memeri effect emboss untuk 

text tersebut, dengan height 7 pixel dan amount 92 pixel, dapat dilihat 

sebagai berikut tersebut. 

 
Gambar 5.180 Tampilan emboss 
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10) Desain foto yang sudah kita buat tadi, tambahkan nama. Lalu save as 

foto dan merubah format menjadi JPEG. Hasil akan sebagai berikut 

tersebut. 

 
Gambar 5.181 Tampilan hasil akhir 
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Tujuan BAB V 

1. Mengetahui dasar dari teknik tools manipulasi 

2. Mampu menguasai dari beberapa teknik manipulasi foto 

3. Mempermudah belajar manipulasi dengan beberapa  penggabungan 

efek dan pencahuaan pada Adobe Photoshop CC 2019   

4. Mempermudah belajara sendiri serta memiliki banyak referensi dari 

teknik-teknik manipulasi 

5. Mempermudah membuat manipulasi dengan ide kreatif dengan 

panduan pada bab V 

 

 

Kesimpulan  

Materi BAB V 

Pada pembahasan kesimpulan di bab V tesebut adalah teknik 

pembuatan manipulasi foto yang mempunyai dasar awal dengan foto 

biasa diberi tambahan dan digambungkan dengan beberapa foto yang 

lebih memiliki arti dari gambar tersebut salah satunya maniulasi manusia 

kayu adalah dengan motif hasilnya serupa boneka kayu yang mempunyai 

arti boneka dengan ditali seperti boneka kayu mainan, jadi memiliki hasil 

yang hampir sama. Selanjutnya membuat manusia robot juga 

digabungkan dengan foto robot dan foto model, jadi hasil yang diinginkan 

adalah manusia setengah robot haya mengandalkan teknik masking dan 

brush. Pada langkah manipulasi juga dibahas bagaimana teknik membuat 

manusia avatar dengan penggabungan gambar model dan gambar seperti 

zebra dengan teknik pencahayaan yang sama. jadi pada pembahasan 

dibab V tersebut lebih mempermudah untuk memanipulasi foto dengan 

lebih mudah yang penting memiliki ide yang kreatif dalam suatu desain. 
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